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This guide is intended for Comindware users and describes the basic  activities you can do  in
Comindware Tracker. 

About this guide
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Introducing Comindware Tracker

Chapter 1

This chapter includes the following topics:

About Comindware Tracker

Basic concepts

Connecting to Comindware Tracker
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About Comindware Tracker

Comindware®  Tracker®  is  a  web-based  workflow  management  and  issue  tracking
system with integrated task management  and collaboration features.  With  Comindware
Tracker,  you  can  visually  design,  automate,  and  optimize  workflow  processes,
streamline  issue  management,  and  automatically  connect  required  actions  with  tasks
and owners for more efficient execution of almost any business activity.

Comindware has a familiar Microsoft® Outlook®-style user interface plus visual drag-&-
drop  controls  for interactive  workflow  design,  form building,  and  more.  You  no  longer
need  a  process  expert  or  programming  help  to  automate  workflow  processes  and
streamline execution, collaboration, and management around:

Tasks and projects

IT help desk requests

Software bugs

General office or HR requests

Documents, claims, and more

Integrated Task Management

With integrated  task  management  capabilities  and  unique  ConnectStep®  technology,
tasks  can be  automatically  generated  and  assigned  as  tracked  items  are  created  or
progressed  from one  step  to  the  next.  With  Comindware  taking  care  of  the  process,
users can focus on executing their tasks while Comindware moves things along.

Workflow Coordination

Orchestrate your team and projects by having tasks automatically generated according
to your Workflows.

Team Collaboration

Collaborate  in  terms  of  your  projects  and  make  your  collaboration  purposeful  and
effective.

Real-time Reporting and Notifications

Get  Real-time  Visibility  into  your  project’s  immediate  status  so  you  can  track  each
project and the whole team’s work, as you like.

Workspaces

Coordinate the work in your area, by function, by department, by project, whatever you
need.

Working with Outlook and e-mail

Work directly from Outlook tasks without switching to another environment.

GUI and User Experience
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Don’t  make  your  team learn  another  environment  –  stick  to  the  familiar  Outlook-like
interface that everyone knows.

Security

Rest  assured  that  you have  the  security  you need,  with  powerful  settings,  backups,
and scalability. Both Cloud and on-premise deployment are possible.

API and Integrations

Enhance whatever systems you are already using with collaborative workflows.
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Basic Concepts

This chapter includes the following topics:

Tasks and documents

Applications, lists

Workspaces, My Desktop

About permissions

Tasks And Documents

Comindware Tracker manages three main types of activities:

different types of tasks: team tasks, personal tasks

requests, issues, cases, tickets, or workflow tasks

wiki pages, customer accounts, or documents

Tasks

Tasks  are  pieces  of  work  that  need  to  get  done.  They  are  parts  of  a  project,  or
components  of  a  day.  They  can exist  on  their  own  or  they  can  be  part  of  a  larger
process with subtasks or workflows. You can assign them to yourself or to members of
your team, and with Comindware Tracker, you can track their status automatically.

To learn how to work with Tasks, see Using tasks .

Workflow Tasks

A workflow task is something which requires the work of several people. An example of a
workflow task may be an Employee Vacation Request, because this request  would need
to  follow  a  number  of  steps  to  be  completed:  Request,  Management  Approval,  HR
Approval, Payroll Notification, and so on. Other examples of workflow tasks are change
requests, help desk tickets, claims, product bugs.

Any workflow task is processed through a workflow pre-configured by a  team manager
or  Comindware  administrator.  A  workflow  is  a  sequence  of  steps  that  should  be
performed to get your work done.

13
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An example of a workflow scheme

Comindware Tracker, powered by ConnectStep  technology,  will  automatically  generate
the tasks you need  done  at  each step  of  a  workflow,  in  the  right  order,  at  the  right
time, by the right person.

Autogeneration of tasks in a workflow

To learn how to work with workflow tasks, see Working with workflow tasks .

Documents

A  documents  a  piece  of  information  which  needs  to  be  stored  and  categorized.
Examples of documents are wiki pages in a wiki library,  client  records  in  a  client  base,
specifications  in  a  spec  library.  Documents  help  you  keep  lots  of  different  types  of
information together, with the ability to track and categorize things.

To learn how to work with documents, see Working with documents .

Applications, Lists

Applications

Tasks or documents of the same type are created and stored in applications or apps.

For  example,  all  employee  vacation  requests  will  be  created  within  the  Vacation
Requests applications, as well as stored, categorized and prioritized there. All wiki pages
items will belong to the Wiki Library app, all bugs  will  belong  to  the  Bug  Tracking  app,
and all client records will belong to the Client Base app.

Each  app  can  have  different  security  settings,  different  people  from  various
departments, and so on.

63
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Lists

Tasks  and  documents  are  accessed  through  lists.  A  list  displays  particular  tasks  or
documents from the app which match particular criteria. For example, "My active tasks"
,"All active features in release", "Daily verified bugs". A task or document  can be shown
in many lists if it matches list criteria.

Each application contains  default  predefined  lists.  For task apps,  the  default  lists  are
"Personal Tasks", "My Active Tasks", "Completed Tasks" and so on. 

For more information about lists, see Configuring lists .

Workspaces, My Desktop

Workspaces

A workspace is a  group  of  people,  a  team or a  project.  For example,  you might  have
department-specific  Workspaces,  such  as  “IT”  and  “Administration.”  You  could  also
have a project-specific Workspace that would include people from several departments,
such as “Sales Kick-Off” or “Building Construction”.

Workspaces  contain  work  tools  for  the  team,  i.e.  tasks  applications  or  document
applications.  In  these  applications  workspace  participants  create  new  items  and
documents and work with them.

Here is an example of how Workspaces and Applications fit together:

Departmental Workspace: IT

Application “Help Desk Requests”

Application “Hardware Inventory”

Application “IT Team Tasks”

Departmental Workspace: Administration

Application “Product Campaign”

Application “Product Review”

Project-Specific Workspace: Sales Kick-off

Application “Budget Committee”

Application “Training Content”

Requestor Workspaces

Requestor Workspace is an area for Comindware users with the Requestor license  type
assigned. Requestor license provides limited access to Comindware Tracker features and
capabilities, for example, Requestors can only  submit  requests  like  Purchase  Requests,
IT Help Desk Tickets, Vacation Requests, etc. and can track their request progress.

My Desktop

My Desktop is your private workspace where you work with tasks and documents. Each
Comindware  user  has  their  own  My  Desktop  area  accessible  only  to  them.  The  My
Desktop  area  contains  tools  to  manage  tasks  and  documents,  and  lists  of  tasks  and

76
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documents which requires your attention. Each user configures the number of lists in My
Desktop as they wish. For example, a user can mark a list in any group as Favorite, and
the list will appear in My Desktop, or create their own list and save it to My Desktop.

About Permissions

Access rights to different Comindware Tracker areas, e.g. workspaces and applications,
are managed through a set  of permissions, or permission levels.  For example,  company
employees  may  have  limited  access  to  the  HR  workspace  or  Accounts  Department
workspace, or a a new QA tester should not have the possibility to delete existing bugs.
Permission levels are granted  by  Comindware  administrators  or Comindware  architects,
who are generally system administrators or team managers.

Comindware Tracker includes four default permission levels.

Owners

o add users or user groups to an application or remove them from the app

o full control over tasks and documents inside an application, including deleting and

editing tasks and documents

o can create and edit lists and dashboards that belong to the application

Members

o can create and manage  tasks  and  documents,  delete  only  tasks  and  documents

they created

o can copy lists  and  dashboards  that  belong  to  the  application to  the  My Desktop

area

o can create and edit their own lists and dashboards in the My Desktop area

Viewers

o can view all tasks and documents (read-only permissions)

o can copy lists  and  dashboards  that  belong  to  the  application to  the  My Desktop

area

o can create and edit their own lists and dashboards in the My Desktop area

Requestors

o can create tasks and documents

o can view, modify and delete only tasks and documents they created

o can copy lists  and  dashboards  that  belong  to  the  application to  the  My Desktop

area (for users who have Comindware Tracker Full license assigned to them)

o can create  and  edit  their own lists  and  dashboards  in  the  My Desktop  area  (for

users who have Comindware Tracker Full license assigned to them).

Requestor permissions  can be  assigned  to  users  with  the  Comindware  Tracker Full
license and Comindware Tracker Requestor license.

The  following  table  lists  the  default  permission  levels  and  permissions  within  each
permission level.
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Program elements Owners Members Viewers Requestors
(users  who
have  Full
License)

Dashboards  within
application Full

control

Copy  to  My
Desktop  (Save
as),

View

Copy  to  My
Desktop  (Save
as),

View

Copy  to  My
Desktop  (Save
as),

View

Own dashboards in  the
 My Desktop area

Full
control

Full control Full control Full control

Lists  within  the
application Full

control

Copy  to  My
Desktop  (Save
as),

View

Copy  to  My
Desktop  (Save
as),

View

Copy  to  My
Desktop  (Save
as),

View

Own  lists  in  the  My
Desktop area

Full
control

Full control Full control Full control

Tasks  and  docs
created  by  other
individuals

Full
control

Modify, View View No access

Tasks  generated  from
workflows  or  created
by  other  individuals
and assigned to user

Full
control

Modify, View Modify, View Modify, View

Own  Tasks  and  docs
within application

Full
control

Full control - Full control

Tasks  or  docs  created
by  e-mail  as  default
creator

Full
control

Full control - Full control
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Connecting To Comindware Tracker

This chapter includes the following topics:

Supported web browsers

Opening Comindware Tracker on a desktop PC or laptop

Opening Comindware Tracker on a mobile device

Supported Web Browsers

Comindware  Tracker  is  a  web-based  solution,  so  users  interact  with  it  using  web
browsers.

Web browsers

Internet Explorer 8.0, 9.0, 10.0

Mozilla Firefox Latest stable version supported

Tested with 3.6, 9.0.1

Google Chrome Latest stable version supported

Tested with 16

Opera Latest stable version supported

Tested with 11.60

Safari for Mac Latest stable version supported

Tested with 5

Safari for iPhone\iPad iOS version 5.1 or higher

Native browser for Android Android version 2.3 or higher

The web browser must support JavaScript and cookies.

Opening Comindware Tracker On a Desktop PC or
Laptop

Comindware  Tracker resides  on a  web  server hosted  in  your corporate  network or on
the  Internet.  You  can  connect  to  Comindware  Tracker  from  any  computer  in  the
network  using  your  web  browser.  Minimum  screen  resolution  should  be  1024  X  768
pixels.

To open Comindware Tracker:

1. Open the web browser. 

2. In the address bar of your web browser, type the Comindware Tracker URL: 

18

18

19
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http://ComputerName:Port, where:

Parameter Description Values

http:// Data  transfer  protocol
specified during installation

http://

https://

ComputerName The  name  of  the  server
hosting  your application.  This
may  be  a  computer  IP
address,  or  a  computer  DNS
name.

localhost

127.0.0.1

LocalComputerName

RemoteComputerName

Port The port number specified
during installation

8081 (default for Comindware
Tracker installation)

80 (default for http
installation)

443 (default for https
installation)

Exam ple:  ht tp://loc alhost ,  ht tp://127.0.0.1,  ht tp://m ylaptoppc ,  ht tps://
bugt rac ker:8081

3. On  the  login  page,  enter  your  user  name  and  password  issued  by  Comindware
administrator and click the Log In button.

The login page

Opening Comindware Tracker On a Mobile Device

You can use Comindware Tracker on your mobile phone or any other mobile device. You
do  not  need  any  special software  installed  except  a  mobile  web  browser.  Make  sure
your mobile device is connected to the Internet  if  your Comindware Tracker installation
is  accessible  through  the  Internet,  or  corporate  network  if  Comindware  Tracker  is
installed in your corporate network.

To open Comindware Tracker on a mobile device:

1. Launch a mobile web browser on your mobile device. 

2. In the address bar of your mobile web browser, type-in the Comindware Tracker URL
in the following format: http://ComputerName:portNumber/mobile/
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3. Enter your login credentials provided by the system administrator and click Log In.

Login page on a mobile

device
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Quick Setup: Create a Work
Environment

Chapter 2

This chapter includes the following topics:

Step 1: Add users and user groups

Step 2: Pre-designed solution or custom solution

Step 3: Create a workspace

Step 4: Create an application

Step 5: Configure an application: set up fields

Step 6: Configure an application: set up the web form

Step 7: Configure an application: create a workflow

Optional setup steps

22
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Step 1: Add Users And User Groups

First, you need to add users who will work with Comindware Tracker. You can add users
from Active Directory or manually and assign a product license to them.

This  type  of  operation  is  performed  by  Comindware  administrators.  If  you  are  a
Comindware  architect,  please  ask  the  Comindware  administrator  to  perform  this
operation.

Adding users from Active Directory

If your company uses Active Directory, import user profiles from Active Directory.

Click Active Directory Integration, specify connection settings and import Active Directory
groups.

See Connecting to Active Directory .

Adding users locally

Otherwise, add users manually into the Comindware Tracker database.

Click Users, then click Add new user, and specify the user information.

See Managing local users .

Assigning a license to the users

After you have added users, license the users to use Comindware Tracker.

Click License  Manager, double-click on the Comindware Tracker license.  In  the  window
that opens, click Assign users, select the users and click Save.

See Assigning users to the product key .

114

110

109
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Step 2: Pre-Designed Solution Or Custom
Solution

Comindware Tracker offers ready pre-designed solutions for various business areas. You
can also create your own custom flexible solutions.

Deploying a pre-designed solution

Each  pre-designed  solution  includes  preconfigured  workflows,  task  and  doc  forms.
Comindware provides ready solutions for:

Finance and Administration,

Compliance & Policy Initiatives,

IT Help Desk,

Human Resources,

Software Development.

Click the Menu tab, click One-click Solution Setup. Double-click on a solution do deploy it
in Comindware Tracker.

See Deploying a pre-designed solution.

After  you've  deployed  a  solution,  you  will  need  to  add  employees  to  a  solution
workspace  and  assign  roles  to  employees  in  workflows.  Go  to   Step  3:  Create  a
workspace , and Step 6: Configure Applicaion: create a workflow .

Creating your own solution

In most cases, you will need to configure your own solution. Configuration includes the
creation of a workspace and creation of applications in a workspace.

24 28
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Step 3: Create a Workspace

First,  you  need  to  create  a  workspace.  A  workspace  provides  a  group  of  people
(department, project, remote office, or simply several people) with a set  of applications
to manage tasks, docs, and workflows.

Click Create  Workspace  in  the  left  part  of  the  window.  Specify  the  workspace  name,
description and click Save. You will proceed to the workspace configuration step, where
you will: 

add workspace participants: click Security and add users and user groups  who  will
work with the workspace

create applications (steps 4-7)
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Step 4: Create an Application

Applications create, keep, and organize tasks or docs of the same type. There are three
types of applications in Comindware Tracker:

applications to create and store workflow tasks, or Workflow  Apps. A workflow task
is something which requires attention of several people in turn in your department,
for example, a customer claim, a tracking issue, a help desk request.

applications  to  create  and  store  different  tasks  scattered  across  your  team,  or
Tasks Apps.

applications to create and store documents of the same  type,  or Documents Apps,
for example, wiki articles in a wiki library or customer records in a customer base.

Open a workspace, in the left  part  of the window click Create  application...  and choose
the application type. Specify the app name, description, click Save. Then configure the
app settings: what  information app  items  should  keep,  how  they  should  look like,  and
how  they  should  be  processed.  Add  app  members  and  assign  security  permissions  to
them.

See Configuring applications .34
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Step 5: Configure Application: Set Up Fields

Fields  retain  all  the  information  you  want  to  see  in  your  tasks  or  docs.  You  can
customize Comindware default  fields by adding extra or removing unnecessary  fields.  A
field may be visible or invisible in the task or doc or may be used to perform calculations
for another visible field.

Go  to  an  application,  click  Fields.  Click  New  Field,  select  field  type.  Configure  field
properties and save the field.
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Step 6: Configure Application: Set Up The Web
Form

After all  the  necessary  fields  are  created,  you can set  the  look  of  how  they  will  be
displayed,  i.e.  customize  a  form layout.  You  can  customize  the  default  web  form by
adding or removing web form elements.

In  an application,  click Form.  Drag  and  drop  existing  fields  from the  left  part  of  the
window into the middle part  of the  window.  Select  a  form element  in  the  middle  part,
and specify field properties in the right part. Save the form.

See Creating a web form .37
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Step 7: Configure Application: Create a
Workflow

After the fields and a  web  form are  created,  you should  configure  how  your workflow
tasks will be  processed,  i.e.  configure  a  workflow.  A  workflow  is  a  sequence  of  steps
that should be performed to get your work done.

In a workflow app, click Workflow. Modify the workflow diagram: drag statuses from the
left part of the window and drop them into the canvas area. The status will turn into a
workflow  step.  Double  click  on  the  step  to  specify  its  settings,  e.g.  assignee  and
transition  rules.  Interconnect  steps  with  transitions.  Double  click  on  a  transition  to
specify its settings. When finished, click Save Workflow.

See Configuring a workflow .40
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Optional Setup Steps

Now you and your company  are  ready  to  use  Comindware  Tracker.  However you may
take optional configuration steps.

Optional Step 1: Add Company Logo

You can customize Comindware Tracker with your company and favicon in the  address
bar of a web browser. Click Custom Logo, select  the Enable  check box, upload pictures
of 150x35 pixels and 24x24 pixels in size and a favicon.ico file.

This type of operation is performed by Comindware administrators.

See Adding a custom logo .

Optional Step 2: Configure E-mail Notifications

You can configure Comindware Tracker to send e-mail notifications to Comindware users
when a particular event  occurs with a task or document,  or to  send  scheduled  e-mail
reports. To enable this feature you should connect  Comindware Tracker to a corporate
e-mail  server.  Click E-mail  Notifications,  select  the  Enable  Outgoing  E-mail  check  box,
choose either Microsoft Exchange server or SMTP, and fill in the server settings.

This type of operation is performed by Comindware administrators.

See Configuring outgoing e-mail settings .

Optional Step 3: Configure Item Creation From
E-mails

Your tasks and docs can be automatically created directly from e-mail messages sent to
a particular e-mail address associated with a Comindware app. As soon as you send an
e-mail to such e-mail address, the e-mail becomes a task or document.

This type of operation is performed by Comindware administrators.

Click Create Items by E-mail, then click New Account and fill in the account settings.

See Configuring Comindware Tracker to create items from e-mails .
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Creating a Work Environment

Chapter 3

This chapter includes the following topics:

Deploying a pre-designed solution

Configuring a workspace

Creating applications inside a workspace

Configuring an application: creating fields

Configuring an application: create a web form

Configuring an application: create a workflow

Adding existing applications in a workspace
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Deploying a Pre-Designed Solution

You can deploy a ready pre-designed solution if  it  corresponds  to  your business  area.
Comindware Tracker provides ready solutions for:

Finance and Administration,

Compliance and Policy Initiatives,

IT Help Desk,

Human Resources,

Software Development.

Each  pre-designed  solution  includes  preconfigured  applications  with  workflows,  web
forms, data, etc.

To deploy a pre-designed solution:

1. Click the Menu tab. 

2. Click Welcome and select One-click Solution Setup.

3. Select a solution to install it into Comindware Tracker.

Deploying a pre-designed

solution

After you've deployed a solution, you will need to add users into the solution workspace
and assign roles to employees in workflows. See Managing workspace users and security

, Configuring a workflow .32 40
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Configuring a Workspace

A workspace is an area for a team, project or department  to manage different  activities
in this team or project.

For example, in a software development  company you may have  a  Support  Workspace
for  the  Support  team,  a  QA  Workspace  for  the  QA  team,  a  Product  Management
Workspace for Product Managers, and a Human Resources Workspace.

Each  workspace  includes  applications  where  tasks  and  documents  are  created  and
stored along with interactive charts, and lists of tasks and documents.

Custom workspaces

How to create a workspace:

1. Click New Workspace in the lower left part of the window. 

2. Specify a workspace name, for example, HR Dept, Project  Development,  Designers,
and workspace description.

3. Click Save to create a workspace and proceed to its configuration: 

Add workspace participants

See Managing workspace users and security settings

Create new applications or add existing applications

See Configuring applications inside a workspace

Managing Workspace Users And Security Settings

You  can  add  workspace  participants  either  by  adding  individual  users  or  by  adding
groups of users. When you add workspace participants, you also assign a different  set
of permissions to them.

To manage workspace participants:

1. Select a workspace in the left part of the window and click the workspace title. 

2. Click Security.

3. Choose a security permission you want  to  assign to  a  user in  the  left  part  of  the
window.  A  final  set  of  permissions  for  a  user  also  depends  on  the  user  role  in
Comindware  Tracker:  Comindware  administrator,  Comindware  architect  or  an
ordinary user.

Comindware administrator:

o have full set of permissions in the workspace

Comindware architect added as a workspace owner:

32

34
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o have full set of permissions in the workspace

Comindware architect added as a workspace viewer:

o can create tasks and docs in the workspace

o cannot create and manage applications

o cannot modify security settings

Comindware user added as a workspace owner:

o can create tasks and docs in the workspace

o cannot create and manage applications

o can modify security settings

Comindware user added as a workspace viewer:

o can create tasks and docs in the workspace

o cannot create and manage applications

o cannot modify security settings

4. Click Save & Close.
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Creating Applications Inside a Workspace

An application is  a  group  of  tasks  or  documents  of  the  same  type.  There  are  three
types of applications in Comindware Tracker:

applications for workflow tasks, or Workflow  Apps. A workflow task is  something  that
requires  attention  of  several  people  in  turn  in  your  department,  for  example,  a
customer claim, a tracking issue, a help desk request.

applications for different tasks scattered across your team, or Tasks Apps.

applications  for documents  of  the  same  type,  or Documents Apps,  for  example,  wiki
articles in a wiki library or customer records in a customer base.

List of groups

You can create  as  many  applications  as  you wish for each workspace,  depending  on
your needs and the data you work with.

How to create an application:

1. Click Create application in the left part of the window. 

2. Specify  application  Name,  for  example,  "Help  Desk  Tickets"  for  a  Workflow  app,
"Client Base" for a documents library, "HR Tasks" for Tasks app).

3. In the Description field, provide a short summary what your application does.

4. Click Save. After clicking Save you will be redirected to the application configuration
page where you configure all application settings: 

Fields: or what information an item will retain.

See Creating fields

Form: or what your items will look like.

See Creating a web form

Workflow: (for a workflow app) how your workflow tasks will be processed.

See Configuring a workflow

Security:  grant  permissions  to  your  colleagues  to  work  with  the  app,  or  remove
these permissions.

E-mail  notifications: send e-mails to particular people  when particular events  occur
with tasks or documents inside an application.
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Export  to  Word:  configure  the  look of  tasks  or docs  when they  are  exported  to  a
Microsoft Word doc file.

Configuring an Application: Creating Fields

Fields retain all the information you want  to be present  in your task or document.  You
can  use  default  fields  in  your  form  and  create  your  own  fields.  Each  new  field  is
automatically added to a global category of fields and can be used in other applications.
We  strongly  recommend reusing  existing  fields  as  you will  be  able  to  create  different
types of charts, lists, based on the data taken from different  workflows. You can make
a field visible or invisible in the form, or use a field  to  perform calculations  for another
visible field.

To create a new field:

1. Select the application and click Fields. 

2. In the Ribbon, click New Field.

3. In the Name field, specify a name that will be displayed to users.

Editing a field

4. In the  ID field, a unique ID is required for internal identification of the field.  The  ID
should start with a Latin letter.

5. In the Type field, choose the type of field data. The following types of field data are
available:

Name Description

Text A text string field to store any plain text.

Number A field to store any numeric value, e.g. 10, 1024, -15.

Date/Time A  field  that  stores  year,  date,  and  time,  in  the  format
according to the regional settings of the operating system of
your web server.

Duration A field that shows the total span of active working time for a
task as  entered  or  as  calculated  based  on  start  date  and
finish date.
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Name Description

List of Values Stores  a  number of  predefined  string  values.  Allows  you  to
choose  one  of  the  values  from  the  drop-down  list.  An
example may be a "Country" field  in  a  registration form that
offers choosing a country from the drop-down list.

Reference Stores a reference to another object, or a hyperlink.

While  designing  a  template  you  might  provide  for  easy
creating  of  related  work  elements  by  users.  You  should
create  fields  referencing  required  groups  for  that.  Don’t
forget  to  add  the  created  fields  to  the  template’s  form as
well.  This  allows  users  to  easily  create  referenced  tasks  or
items by clicking the Related button in the Ribbon.

User allows you to select  a Comindware user from the  drop-down
list.

6. Set the following field properties, if necessary:

Name Description

Multiple values Select  the  check  box  to  assign  the  same  type  of  multiple
values to the field. For example, if  this parameter is checked
for the type of User field, you will be able  to  select  multiple
users.

Read only Select  the  check  box  if  you  do  not  want  the  field  to  be
modified.

Disable  history
logging

Select  the  check  box  if  you  do  not  want  this  field  to  be
logged in History.

Value is unique Select  the check box to check if  the  value  assigned  to  this
field is unique and has not  been assigned before for this field
type.

This value can be applied to Social Security numbers, e-mail
addresses, client IDs, etc.

Calculated A  calculated  field  can  perform  calculations  by  using  the
contents  of  other  fields  using  the  Comindware  Expression
Language. Select  the Calculated check box, and in the Field
Expression  field  specify  your  formula.  See  Comindware
Expression Language Reference Guide.

http://dl2.comindware.com/pdf/Comindware_ExpressionLanguage_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_ExpressionLanguage_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_ExpressionLanguage_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_ExpressionLanguage_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_ExpressionLanguage_Guide_en_A4.pdf
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Field attributes

7. When finished, click the Save & Close button.

Removing a Field

You can remove  a  field  from the  application if  you no  longer need  it  in  your tasks  or
documents. Note that removing a field does not  permanently delete it  from the system.
You can add it again any time you need.

To  remove  a  field,  go  to  an application,  click Fields.  Select  a  field,  click the  Remove
Field button. Click Save App.

Configuring an Application: Creating a Web Form

A web form (or form) is an online document  which shows what  your task or document
will  look like.  A  form contains  pre-filled  fields  along  with  spaces  reserved  for  entering
information. In Comindware Tracker, you can build a web form for your item by adding or
removing web form elements using the familiar drag-and drop model.

Building a form for Bugs in a Form Builder
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A ready form for Bug

How to create a web form:

1. Open the application and click Form. You will see the default  form for the selected
application. 

An example of a form

2. Add the web form elements into the form. In the Ribbon, click on the button which
stands for the element you want to add to the list:

Name Description

New Panel An  element  of  the  form,  which  can  contain  multiple  form
elements, including fields, attachments, tab panels, rich text
fields.

Tab Panel A  panel with  predefined  tabs:  Description,  Discussion,  Time
Spent, History, Subtasks, and Workflow Viewer. You can add
new tabs, customize existing tabs, or remove tabs in the Tab
Panel.

Attachments An element of the form to contain attachments.

Static  Text
Area

An element of the form to contain formatted text.

3. Organize  the  form elements  by  dragging  them to  the  required  position.  You  can
delete  unnecessary  panels  by  selecting  a  form element  and  pressing  the  Delete
button on the keyboard.

4. Select  a  form element  in  the  middle  area  and  customize  its  settings  in  the  right
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area. Depending on the type of  element,  only  some  of  the  below  settings  may  be
available:

Name Description

Main Set  the display name and prompt  text  for the  form element.
The prompt  text  appears inside the form element  as soon as
the page is opened, so users immediately know what it  is for.
You can also hide the  form element  name  or place  it  above
the element.

Size Settings Switch between manual and automatic  resize  modes  for the
form element.

Layout If  the  form element  has  child  elements,  set  the  layout  for
them. You can choose the horizontal or vertical layout.

Edit Select  the  check  box  to  enable  editing  data  in  the  form
element  and  select  the  editor  type.  For  example,  for  a
Reference field you can select one of the following:

Reference explorer — an element, which allows a user to
perform instant  search,  when  the  results  are  displayed
immediately as the user types.

Drop-down list box — an element, for which the list  of all
available values appears when clicked.

Formats Select  one  of  the  formats  of  date  representation.  Available
for Date/Time fields.

Dimension Set  the width or height  of the element, if  the  manual resize
mode is specified.

Padding Set  the left  and  top  padding  values.  Padding  is  the  amount
of  space  to  insert  between the  parent  element's  margin  or
border and its subordinate elements.

5. Preview the form layout by clicking the Preview button in the Ribbon.

6. When the form is ready, click Save.
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Previewing the form

Configuring an Application: Configuring a Workflow

A  workflow  is  a  sequence  of  steps  that  should  be  performed to  get  your  work  done.
Each workflow  step  has  a  task connected  to  it  and  assigned  to  a  particular  person.
Steps  are  interconnected  with  transitions.  Workflows  help  you  automate  your
processes.

Each workflow is associated with a particular project  and particular workflow task type,
and is set up per each workflow application. 

An example of a workflow

A workflow consists of steps and transitions.

A step represents a workflow's current  status for a workflow task. A workflow task can
exist in one step only at  any point  in time. Each workflow step corresponds to a linked
status. Each status can be used in multiple steps or in different workflows.

There are three different types of steps:

Start — the starting point  of any workflow, where you start  working on a  workflow
task.

Intermediate — the number of intermediate steps is not limited.
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End — the end of a workflow. The number of end steps is not limited.

A transition connects two  workflow  steps  thus  allowing  a  workflow  task to  move  from
one step to the next.

Workflow steps

By  default  there  are  only  Start  and  End  steps  in  your  workflow.  You  will  need  to
customize a default scheme, i.e. create steps and transitions, set a default assignee for
tasks created in each step, and set transition rules.

How to create a workflow:

1. Open a workflow application and click on Workflow.  Clicking on Workflow  will open a
graphical workflow builder with a default predefined scheme. 

A workfow diagram

2. In the Statuses list, select an existing status, or create a new status by clicking the
New  Status button.  Statuses  are  required  to  create  a  workflow  step.  Statuses  do
not  belong to a particular workflow — they may be used in  different  workflows,  as
opposed  to  steps  which  are  unique  to  each  workflow.  We  strongly  recommend
reusing  existing  statuses  because  you  will  be  able  to  create  different  types  of
reports, lists and dashboards based on the data taken from different workflows.
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Adding a workflow status

3. Create a new workflow step by dragging a status into the workflow area. A workflow
step is unique for each workflow.

Adding a workflow step

4. Double click the step to specify its settings. See Configuring step properties.

o Specify the step name.

o Specify the step type. This may be a Start, Intermediate, or End step.

o You may want  to change a step status — select  a status from the  list  of  existing

statuses.

o For Start and Intermediate steps, you can choose whether to create a task for the

person responsible  for this  step  or not.  Each time  a  workflow  task  is  in  one  of
these  steps,  a  task will  be  created  for the  person responsible  for  this  step.  As
soon as the task assignee finishes  the  task,  the  workflow  task will  be  moved  to
the next step.

Workflow step settings

5. When  finished,  click  Save  &  Close.  Repeat  the  procedure  for  each  step  in  your
workflow.

6. Interconnect  steps with Transitions. Click the Draw  Transition button in the  Ribbon.
Left-click on the source element and hold the mouse button to create a connection
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starting point. Drag the mouse to the target  element  and release the mouse button
to create a connection.

7. Double-click on the  transition  to  customize  its  settings.  See  Configuring  transition
properties. Click Save & Close when you are finished.

8. When done, click Save Workflow.

Creating Steps

A step is a building block of a workflow. A step shows the current position of a workflow
task in a workflow. Generally, some work on a workflow task should be done in a step,
for example, "Review a document".

To create a workflow step:

1. In a workspace select a workflow app and open a workflow. 

2. In the Statuses list, select an existing status, or create a new status by clicking the
 New  Status button. Statuses are required to  create  a  workflow  step.  Statuses  do
not  belong to a particular workflow — they may be used in  different  workflows,  as
opposed  to  steps  which  are  unique  to  each  workflow.  We  strongly  recommend
reusing  existing  statuses  because  you  will  be  able  to  create  different  types  of
reports, lists and dashboards based on the data taken from different workflows.

3. Create  a  new  workflow  step  by  dragging  a  status  into  the  workflow  area.  A
workflow step is unique for each workflow.

Adding a workflow step

4. Double click on a step to specify its properties.

o Common properties, i.e. step name and type.

o Assign persons responsible for this step. 

o Make several people perform work in an item step. 

o Pre-fill some item fields. 

o Perform automatic transitions based on a time event. 

o Set mandatory fields. 

o Create validation rules. 
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Configuring Step Properties

Step Properties: Common Properties

Double  click  the  step  to  specify  its  settings:  step  name,  step  type  (Start,
Intermediate, or End). You may want  to change a step status — select  a status from
the list of existing statuses.

Step Properties: Responsible Persons

You  can  make  employees  responsible  for  this  step  by  creating  a  task  or  several
subtasks. You can also pre-populate all task fields with values or set  field population
rules.

To assign a responsible person and pre-populate task fields:

1. Double click a required step, and click Responsible  Persons in the left  area of the
Step Properties window. 

2. Select the Assign tasks and pre-populate task fields check box.

3. Click on Task Settings.

4. In the Assignee field, select a user who will be the task assignee

5. Fill in other task fields: task title, due date, etc.

6. When finished, click Save.

Step Properties: Workflow Parallelism

Parallel  tasks  are  useful for splitting  large  or complex work in  a  workflow  step  into
several  tasks.  Parallel  tasks  allow  task  assignees  to  complete  tasks  in  any  order
without  depending on one person creating a  task before  the  second.  Your workflow
step is not complete until all parallel tasks are complete.

Example: An on-boarding checklist  for a new employee. In the On-Boarding workflow
step, you can create several tasks which will be executed in parallel, for example:

an employee completes the Personal Data Form

the IT team sets up the computer, phone, software

the Office Management team provides a new employee with office supplies

the Security office creates a permanent parking permit for a new employee

the  employee's  manager  schedules  an  employee  to  attend  the  Employee
Orientation program.

To create parallel tasks:

1. Double click a required step, and click Responsible  Persons in the left  area of the
Step Properties window. 

2. Select the Assign tasks and prepopulate task fields check box.

3. Click the Create Parallel Task... button.

4. Specify the task settings.
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5. When finished, click Save.

Repeat this procedure for each parallel task.

Step Properties: Pre-Populate Fields

Item fields can be automatically filled in when an item moves to a particular step. You
can set  an exact  value  for the  field,  calculate  a  field  value  using  the  Comindware
Expression language, or clear the field value as soon as the item moves  to  the  next
step.

To pre-populate item fields:

1. Double click a required step, and click Pre-populate  Fields in  the  left  area  of  the
window. 

Pre-populate Fields w indow

2. Select a field you would like to fill in and click Set Value...

3. Choose how you would like to pre-populate the field: 

Name Description

Set  a  default
value

You can set an exact value to the field.

Type  a  rule
expression
using  the
Comindware
Expression
language

Item  field  can  be  calculated  using  the  formula
written  in  the  Comindware  Expression  language.
 See  Comindware  Expression  Language  Reference
Guide.

Delete  the
field  value
when  an  item
enters  the
next step

The field value will be cleared.

http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
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Pre-populating the Date field

4. When finished, click Save & Close.

5. Click Save Workflow.

Step Properties: Automatic Time-Based Transitions

You  may  configure  your  workflow  tasks  to  be  automatically  moved  to  the  next
workflow step. This may be useful in the following situations:

if a document needs to be to be commented on by workflow participants. If there
are  no  comments  in  the  specified  period  of  time,  a  workflow  task  moves
automatically to the next workflow step.

to automatically escalate workflow tasks that were not resolved on time. You can
set  a  value,  indicating  how  much  idle  time  should  elapse  before  Comindware
Tracker automatically moves a work item to the appropriate step.

if you have support cases which should be moved to the End step automatically.

You can configure an automatic  transition to the next  step on a given weekday and
time, or using the formula written in the Comindware Expression language.

To configure an automatic transition:

1. Double  click  the  required  step,  click  the  Time-based  transition  tab,  select  the
Enable auto-transition based on a time event check box. 

2. If you want  the transition to be performed automatically after a  specified  period
of time, select  the Move  item to next step when step duration exceeds this timeout
option and enter the period length.
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Configuring an automatic transition

Click the Use the Comindware  Expression language  rule  to calculate  duration time  if
you want to configure an automatic  transition to the next  step using the formula
written  in  the  Comindware  Expression  language.  See  Comindware  Expression
Language Reference Guide.

Step Properties: Mandatory Fields

You can make certain fields mandatory in a workflow task. These fields will be filled in
by  the  task  owner  before  they  press  the  Next  step  button  or  save  the  item.
Mandatory fields can be assigned to both steps and transitions.

How it works

Comindware  Tracker  checks  for  mandatory  fields  each  time  when  a  workflow  task
enters this step, exits the step, or each time you click Save in this step.

To add mandatory fields:

1. Click the Steps tab and then double-click the required step to specify its settings.
 

2. In the left part of the window that opens, click Mandatory Fields.

3. Add or remove fields using the Add, Add All, Remove, Remove All buttons.

4. When finished, click the Save & Close button.

5. Click Save Workflow.

http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
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Adding mandatory fields

Step Properties: Validation Rules

Validation  rules  verify  that  the  data  a  user  enters  in  a  workflow  task  meets  the
criteria you specify. A validation rule can be  applied  to  one  or more  task fields  in  a
particular  step  or  transition.  Validation  rules  are  created  using  the  Comindware
Expression language. Validation rules can be assigned to both  steps and transitions.

How it works

A rule will be applied when a workflow task is saved in this particular step or enters or
exits the step or transition. You cannot  move a workflow task to the next  step until
you enter something that satisfies the rule.

To create a validation rule:

1. In the left part of the Step Properties window, click Validation Rules. 

2. Click Add Rule...

3. In the Rule name field, specify a rule name.

4. In  the  Rule  expression  field,  specify  an  expression  written  in  the  Comindware
Expression  language.  Click  the  Auto  Complete  button  in  the  Expression  Editor
window  for  a  complete  list  of  available  Comindware  expressions.  To  view
Comindware Expression usage  examples,  click the  Help  button in  the  Expression
Editor.  See Comindware Expression Language Reference Guide.

Creating Transitions

All intermediate steps in a workflow must be interconnected with transitions.

To create a transition:

1. In a workspace select a workflow app and open a workflow. 

2. Click the Draw Transition button in the Ribbon.

3. Left-click on the source element and hold the mouse button to create a connection
starting point.

http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_WebServices_Guide_en_A4.pdf
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4. Drag the mouse  to  the  target  element  and  release  the  mouse  button to  create  a
connection.

5. Click on a  circle  in  the  middle  of  the  transition  and  choose  a  transition  name  to
configure its properties:

o Common properties,  i.e.  transition  name  and  type.  This  step  is  similar  to  "Step

properties".

o Pre-fill some item fields.

o Assign permissions to Comindware users to perform a transition

o Set mandatory fields.

o Create validation rules.

Configuring Transition Properties

Transition: Managing permissions 

A Comindware administrator or architect can grant permissions to particular users and
user  groups  to  perform particular  transitions.  By  default,  everyone  can  perform  a
transition.

To manage permissions:

1. Open a workflow application, click Workflow and select the Transitions tab. 

2. Double-click the required transition to specify its settings.

3. In the left part of the window that opens, click Permissions.

4. Add or remove users or user groups using the Add, Add All, Remove, Remove  All
buttons.

5. When finished, click the Save & Close button.

Assigning permissions

Transition: Mandatory fields

Configuration of mandatory fields is the same as for step fields. See Mandatory fields

Transition: Validation rules
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Creation of validation rules is the same as for step fields. See Validation rules

Saving or Printing The Workflow Scheme

You  can  save  any  Comindware  Tracker  workflow  scheme  as  an  image  in  the  *.png
format  or print  it. This may be useful if  you want  to  explain  your workflow  process  to
your team, or show your processes to a solution provider.

To save or print the workflow scheme, open a click the Workflow tab in a workflow task,
click Save as Image or Print  the Workflow Scheme buttons in the upper right  corner of
the workflow scheme.

Configuring Application Security Settings

After the application is created, add users and user groups who will work with it. When
a user or a user group  is  added  into  an application,  they  will  be  assigned  one  of  four
default  permission levels. A permission level is a collection of permissions which can be
assigned to users and user groups within a particular application.

Comindware Tracker includes four default permission levels.

Owners

o add users or user groups to an application or remove them from the app

o full control over tasks and documents inside an application, including deleting and

editing tasks and documents

o can create and edit lists and dashboards that belong to the application

Members

o can create and manage  tasks  and  documents,  delete  only  tasks  and  documents

they created

o can copy lists  and  dashboards  that  belong  to  the  application to  the  My Desktop

area

o can create and edit their own lists and dashboards in the My Desktop area

Viewers

o can view all tasks and documents (read-only permissions)

o can copy lists  and  dashboards  that  belong  to  the  application to  the  My Desktop

area
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o can create and edit their own lists and dashboards in the My Desktop area

Requestors

o can create tasks and documents

o can view, modify and delete only tasks and documents they created

o can copy lists  and  dashboards  that  belong  to  the  application to  the  My Desktop

area (for users who have Comindware Tracker Full license assigned to them)

o can create  and  edit  their own lists  and  dashboards  in  the  My Desktop  area  (for

users who have Comindware Tracker Full license assigned to them).

Requestor permissions  can be  assigned  to  users  with  the  Comindware  Tracker Full
license and Comindware Tracker Requestor license.

The  following  table  lists  the  default  permission  levels  and  permissions  within  each
permission level.

Program elements Owners Members Viewers Requestors
(users  who
have  Full
License)

Dashboards  within
application Full

control

Copy  to  My
Desktop  (Save
as),

View

Copy  to  My
Desktop  (Save
as),

View

Copy  to  My
Desktop  (Save
as),

View

Own dashboards in  the
 My Desktop area

Full
control

Full control Full control Full control

Lists  within  the
application Full

control

Copy  to  My
Desktop  (Save
as),

View

Copy  to  My
Desktop  (Save
as),

View

Copy  to  My
Desktop  (Save
as),

View

Own  lists  in  the  My
Desktop area

Full
control

Full control Full control Full control

Tasks  and  docs
created  by  other
individuals

Full
control

Modify, View View No access

Tasks  generated  from
workflows  or  created
by  other  individuals
and assigned to user

Full
control

Modify, View Modify, View Modify, View

Own  Tasks  and  docs
within application

Full
control

Full control - Full control

Tasks  or  docs  created
by  e-mail  as  default
creator

Full
control

Full control - Full control

The set of permissions in a permission level cannot be changed.
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Adding users and assigning permissions

Users and user groups are be added into a group by group Owners. By default, the first
group Owner is a group creator.

To assign a permission level to a user or a user group:

1. Go to Administration > Groups. 

2. Select the group in the list and click Edit.

3. In the left part of the window, select a permission level: Owners, Members, Viewers,
and Requestors.

4. Add or remove  users  or user groups  using  the  Add,  Add  All,  Remove,  Remove  All
buttons.

5. When finished, click the Save & Close button.

Managing users in a group, assigning permissions

Setting Up E-mail Notifications

An application owner can create  an  e-mail  notification  scheme  to  notify  Comindware
users  and  user groups  when a  task or a  document  which  belongs  to  this  application
changes or an event occurs.

To set up e-mail notifications for an application:

1. Click E-mail Notifications inside an application. 

2. Double-click on an event  type,  and  choose  notification recipients  who  will  receive
an e-mail notification when the event occurs:

o Creator: an e-mail notification will be sent to task or document creator.

o Current assignee: an e-mail  notification will  be  sent  to  the  person who  currently

owns the task or document.

o All  Followers:  an  e-mail  notification  will  be  sent  to  users  who  follow

task\document progress (i.e. who clicked the Follow button for this task).

o Other Comindware  users and  user  groups:  select  a  user or a  user group  who  will

receive the notifications on the selected event.

3. Click Save.
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Setting the e-mail notification scheme

Configuring Export To Microsoft Word

Comindware Tracker makes it  possible to export  your tasks  and  items  into  a  Microsoft
Office  Word  2007,  2010,  or  2013  document.  To  enable  this  feature,  a  Comindware
administrator or Comindware architect  should have a configured  Microsoft  Word  export
template file for each particular item type.

A  Word  export  template  is  a  Microsoft  Word  document  in  the  *.docx  format,  which
contains mapping to Comindware Tracker fields and a preconfigured document layout.

By  default,  Comindware  Tracker  provides  each  Comindware  template  with  a  default
Word export template. The default Word export template does not require customization
for importing tasks.

Configuring a Word Export Template

A  Microsoft  Word  export  template  configuration  includes  adding  Comindware  Tracker
item fields  into  a  Microsoft  Word  document,  and  configuring  the  look  of  a  Microsoft
Word document.

To configure a Microsoft Word export template file:

1. Create a new Microsoft Word 2007, 2010, or 2013 document  (*.docx) which will be
a Word export template file. 

2. Open an application and click Fields.

3. Open a field by double clicking on it.

4. Copy a field ID and paste it into a Word export template file in the following format:

Field name1: {field identifier1}
Field name2: {field identifier2}
Field name3: {field identifier3}
Field name4: {#field_identifier}
Field name5: {attachments}
...

where  Field  name  is  the  name  of  the  field  you  type-in  manually,  and  {field
identifier},  {#field_identifier},  {attachments}  are  Comindware  Tracker  field  IDs
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which return different types of values:

Pattern Description

{field_identifier}
returns a value of a text field

{#field_identifier}
returns  a  value  of  a  field  of  the
Reference type

{attachments}
returns a list of attachments

5. Repeat this procedure for each field in the template.

6. Create  the  look you want  for the  Word  document:  styles,  fonts,  font  sizes,  add
your company logo into  your Word  template  file.  For example,  you might  add  text
strings delimited by hard returns, or you may want to organize them in a table.

7. Save the Word export template file.

Word export template and results of the export operation.

Uploading a Word Template File Into Comindware Tracker

After you have  configured  your Microsoft  Word  Export  template,  you should  upload  it
into Comindware Tracker.

To upload a Word export template file:

1. Open an application, click Export Settings. 

2. Click Upload Word File  button and choose a Microsoft  Word document  you want  to
upload as a template.

3. Click Save.

As soon as you upload an export template, the Download link appears and allows you to
download the uploaded template.
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Adding Existing Applications In a Workspace

You  can  add  existing  applications  from other  workspaces  into  your  workspace.  The
application will be accessed from both workspaces. After you have added an application
into a workspace, add users from the new workspace into application security settings.
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Working With Tasks, Workflows,
Documents

Chapter 4

This chapter includes the following topics:

Using team tasks

Working with workflow tasks

Working with documents

Managing tasks and documents

Searching for tasks and documents

Subscribing to task/document notifications
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Using Team Tasks

Tasks  are  pieces  of  work  that  need  to  get  done.  They  are  parts  of  a  project,  or
components  of  a  day.  They  can exist  on  their  own  or  they  can  be  part  of  a  larger
picture with subtasks or workflows. You can assign them to yourself or to  members  of
your team, and with Comindware Tracker, you can track their status automatically.

For Team Manager: Create And Assign Tasks

You  can  distribute  work  by  assigning  tasks  and  dividing  a  larger  task  into  smaller
subtasks.

How To Create a Team Task

To create a new team task:

1. In the My Desktop area click the New button in the Ribbon. 

2. Select the type of task you want to create.

Selecting a task type

3. Fill in the required task fields, as shown in the screenshot:

Creating a task

4. Assignee : Each task can be assigned to one  person at  a  time.  To  involve  more
than  one  person  to  work  on  a  single  task,  create  subtasks  for  each  of  the
participants, linking the subtasks to the parent task. See Creating subtasks .

5. Task Name: The Task Name field can contain any alphanumeric characters.

6. Priority: Set task priority (low, medium or high).

58
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7. Due  Date: Determines when the task needs  to  be  completed.  Tasks  with  a  missed
due date will be marked red in lists.

8. Status ,  % Complete :  You  can  create  a  new  task  and  assign  it  a  status  of
partially or totally complete.

9. Attach a file to the task by clicking Add Attachment in the List pane.

10. Description: The Description area clarifies the task details and completion criteria to
the  task  assignee.  You  can  apply  rich  text  formatting  to  your  text  using  font
options (bold, italics, underline), bullets and numbering, alignment, font color, and to
spell check the text for mistakes.

11. Click Save after filling in the task details. Once the task has been created it  will be
listed in the assignee's tasks list.

There are other ways to create a task in Comindware Tracker: 

by creating a task in Microsoft  Outlook. Comindware  Tasks  for Outlook is  required.
See Microsoft Outlook tasks .

by sending an e-mail message to a particular e-mail address from your e-mail client
if  Comindware administrator has enabled such functionality. See Creating a task by
sending an e-mail .

How To Assign a Task

Each task must be assigned to someone. The person who receives the task can decline,
accept  or assign it  to someone else. If they decline the task,  it  is  returned  to  you.  If
they  accept  the  task,  they  become  the  task  assignee.  If  they  assign  the  task  to
someone  else,  the  new  person  becomes  the  task  assignee,  and  gets  the  choice  to
accept/decline/reassign the task and so on.

To assign a task, select a task, click Reassign and select a new task assignee. You can
also assign a task to yourself by clicking Assign to Me.

Assigning a task to another user

How To Create a Subtask

Subtasks  let  you  split  up  a  big  task  into  a  number  of  smaller  tasks  which  can  be
assigned and followed  separately.  Usually  it  gives  a  better picture  of  the  progress  on
the  task,  and  allows  each person involved  in  resolving  the  task to  better  understand
what part of the process they are responsible for.
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Subtasks can be created for any task in any status, except for tasks in the "Completed"
status.  Subtasks  can have  references  to  other tasks,  subtasks,  and  documents.  The
number of subtasks is unlimited.

Subtasks are created from the  parent  task screen.  Click on the  Subtasks tab,  specify
task name and assignee, and click Create.

Creating subtasks

How To Create a Recurring Task Or Workflow

A recurring a task is a task which repeats in a defined period of time and  needs  to  be
completed multiple times. Recurring tasks help you handle a lot of repeated stuff you do
not want to forget about:

write a weekly report (every 7 days on Friday)

discuss project status (every business day at 12 PM)

change water filter in coffee maker (every 30 days)

You can set  recurring  tasks  to  particular dates,  or regenerate  tasks  with  a  specified
time in between occurrences.

To create a recurring task: 

1. In an open task, click Recurrence. 

2. In the Recurrence dialog box, click the frequency (Daily, Weekly, Monthly or Yearly)
with which the task should recur, and then do one of the following:

Make the task recur at set intervals: In the Recurrence  pattern section, select  the
options for the frequency interval that  you want.  Do  not  select  Regenerate  new
task or the task will not recur at regular intervals.

Make the task recur based on completion date: Select Regenerate new task, and in
the box, type the amount of time after which a new task must be generated.

3. Select the Create a new  task only after completing the  previous task check box if  you
want  to pause creation of recurring tasks or items if  the previous recurring task or
item has not been completed yet.

4. Select  the  Copy  comments check box to  copy  all  comments  to  recurring  tasks  or
items being created.

5. Select  the Copy attachments check box to copy all comments  to  recurring  tasks  or
items being created.
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6. Click OK.

Setting task recurrence

How To Delete a Task

You might need to delete a task created by mistake, or a duplicated task. If a task has
subtasks, they will be removed as well. A deleted task cannot be restored.

To delete a task, select the task you want  to delete and click the Delete  button in the
Ribbon.

For Team Member: Work With Tasks

How To Accept a Task

Each  newly  assigned  task  must  be  accepted  or  declined  by  its  assignee.  If  a  task
assignee  declines  a  task,  the  task is  returned  to  its  creator.  Click  Accept  or  Decline
button in the ribbon.

How To Change Task Status

A task can have one of the following task statuses:

Name Description

Not Accepted A task in any status which has  been assigned  to  its  perspective
assignee, but not yet accepted or rejected by them.

Not Started The default  status for a new task that  has just  been created, or
for a task that has been accepted.

In Progress A task which has already been started, but not yet finished.

Declined A  task rejected  by  its  assignee.  The  task  can  be  reopened,  or
reassigned.
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Name Description

Deferred A task, whose completion is postponed for the future.

Completed A task that has no more work to be done.

To change the task status, select  a task and click Start, Defer, or Complete  buttons in
the Ribbon.

How To Update % Complete

As a task assignee works on a task, they should update the Percent Complete  value. By
specifying a percentage of completion between 0 (for a  task that  hasn't  started)  and
100 (for a task that is finished), you can compare planned progress to actual progress. 

To update the completed percentage:

1. Open the task by double-clicking on it. 

2. Go to the % Complete box.

3. Click the  arrow  buttons  to  increase  or decrease  the  Percent  Complete  value  (the
increment value is 25 percent) or type your own value.

4. Click the Save button.

How To Log Time Spent On a Task

Time  tracking  ensures  that  your  business  tasks  remain  accurate.  Time  tracking  is
important  for  measuring  labor  productivity,  and  allows  it  to  be  improved  where
necessary.

To log time spent on a task:

1. Select a task. 

2. In the Time Spent tab, click Log time.

3. Specify the amount of time you spent on the task.

4. If necessary, you can log a comment for your Time Spent value.

5. Click Save.
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Logging time

How To Create a Personal Task

Personal tasks  are  accessible  only  to  their  creator.  A  task  created  by  another  user
cannot be marked as personal.
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Working With Workflow Tasks

A  workflow  task  is  something  that  requires  the  work  of  several  people.  Examples  of
workflow  tasks  include  bugs,  enhancements,  vacancies,  requirements.  With  workflow
tasks  you can control processes  within  your company  or department,  for  example,  in
Software  Development  using  bugs  will  help  you  manage  the  quality  of  your  product.
Workflow tasks also help the team track and coordinate their work.

In Software Development, workflow tasks can be used for the following purposes:

software bug

a support case

a help desk ticket

In Human Resources, workflow tasks can be used for the following purposes:

a vacancy

a job applicant

a leave request

Comindware Tracker comes with a number of readymade solutions for multiple  areas  of
your  business,  each  of  which  has  its  own  item  types.  However,  workflow  tasks  in
Comindware  Tracker are  configurable  which means  you can create  any  item type  for
any industry.

How to create a workflow task:

1. Go to My Desktop, and click New in the Ribbon. 

Creating a workflow task

2. Select the type of a workflow task you want to create.

3. Fill in all the required fields and click Save.

As soon as you have clicked Save while creating a workflow task, a task will be created
for the person who is responsible  for the  current  item step.  Task completion moves  a
workflow  task to  the  next  step.  When a  workflow  task moves  to  the  next  step,  the
system creates a new task and assigns it  to the person responsible for that  new  step
and so on.

You can also create a task by sending an e-mail message to a particular e-mail address
from your e-mail client  if  the Comindware administrator has enabled  such functionality.
See Creating a task/item by sending an e-mail  for details.69
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Working On a Workflow Task

As soon as a workflow task is assigned to you, you should perform your part  of work on
it. While working, you might need to update it, for example, add a comment, or attach a
file.

When you have finished working with a workflow task, click the  Next  Step  button,  and
select a transition. You can add comments when you move a workflow task to the next
step.

Saving Or Printing The Workflow Scheme

Saving  or  printing  a  workflow  scheme  may  be  helpful  if  you  want  to  explain  your
workflow process to your team or show your processes to a solution provider.

To save or print the workflow scheme:

1. Select a workflow task and click the Workflow Viewer tab. 

2. Click the Save as Image  icon, enter a location to save the image to. The image will
be saved as a .png file.

3. Click the Print the Workflow Scheme icon to print the scheme.

Printing or saving the workflow
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Working With Documents

A  Comindware  document  is  a  piece  of  information  which  needs  to  be  stored  and
categorized. Examples of documents are:

wiki pages in a wiki library

client records in a client base

specifications in a spec library

customer accounts in a customer database

a product release or iteration in Software Development

Documents help you keep lots of different types of information together, with the ability
to track things like update of wiki pages and salary history.

Each document  belongs to an application. A wiki page belongs to a wiki library, a  spec
belongs  to  a  spec  library,  customer  account  information  belongs  to  a  customer
database.

How to create a document:

1. Go to My Desktop, and click New in the Ribbon. 

Selecting an item type

2. Select the type of a document you want to create.

3. Fill in all the required fields and click Save.
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Managing Tasks And Documents

This chapter includes the following topics:

Creating a related task or document

Cloning a task or document

Moving a task/document to another application

Attaching a file

Adding comments

Exporting to Microsoft Word

Creating a task/document by sending an e-mail

Creating a Related Task Or Document

While working on a task, you might need to start new activities that  are related to your
current work, such as:

create a new software bug

assign an issue

create a new customer for a support request

create a new supplier for a purchase request

add an article to the knowledge base

If your current task comes with references to other work elements and such references
are not read only, you can easily create one more referenced work element  of the same
type.

The list of related tasks and documents available for creation.

To create a related task or document:

1. Open your current task or document. 

2. Click the Related button in the Ribbon and select a work element to be created from
the list  of available ones. Alternatively, you can create a related item directly from
a reference field by clicking the Create Related Task... button.
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3. Fill  in  the  required  fields  and  click  Save.  A  reference  to  the  newly  created  work
element will be set as the reference field value automatically.

The created item is automatically referenced by Comindware

Tracker.

4. Click the Save button in the Ribbon to apply changes to the current item.

Cloning a Task or Document

If  you have  to  create  and  manage  many  tasks  or  documents  of  the  same  type,  for
example, payments, you may reuse your existing  tasks  and  documents  by  cloning  and
slightly modifying them after they are cloned. You can create one or more exact  copies
of a payment, changing only required data.

A cloned task or document is a separate entity from the original one. Operations on the
original task/document  have  no  effect  on the  clone  and  vice  versa.  A  cloned  task or
document  is an exact  copy of the original one, containing the same  information stored
in the original task/document with the following exceptions:

a new ID is generated for a clone

the 'Title' field of a cloned task or document  is prefixed with the string 'Copy of' to
indicate that the element is a clone

a cloned workflow task starts from the initial point  of  a  workflow  – from the  Start
step, therefore appropriate values will be assigned to the Step and Status fields.

Cloning is enabled for a user, only if  they have access for creating tasks or documents
in the current application.

To clone a task or document:

1. Open the task or document you want to clone. 

2. Click the Clone button in the Ribbon.

3. Modify a created clone if necessary. For example, replace the ‘Copy of‘ prefix in the
title with a more sensible one.

4. Click the Save button in the Ribbon.
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Moving a Task/Document To Another Application

If  you  face  situations  where  tasks  or  documents  are  not  created  in  the  right
applications, moving them from one application to another in a couple of  clicks  can be
very useful. For example, there  are  software  bugs  related  to  different  departments  of
your company.  If  a  software  bug  is  created  in  a  department  by  mistake,  it  may  be
useful to move this bug to another application, thus moving it to the right department.

Moving  to  another  application  is  available  for  a  user,  only  if  they  have  sufficient
permissions both in the source application and in the target application.

To move a task or a document to another application:

1. Open the task or document you want to move. 

2. Click the Move to App button.

3. Select the required application.

4. Click the Move button.

Attaching a File

You can attach any type of file to a task or document. Comindware Tracker keeps track
of  previous  versions  of  the  attachment  if  you  need  to  update  the  attachment.
Attachments are shared across all tasks and subtasks within a parent workflow task.

To attach a file, select the task or doc to which you want  to attach a file, select  a file
and click Save.

Adding Comments

Comments  allow  you  to  record  additional  details  about  a  task,  thus  facilitating
collaboration with team members. Comments are shown in the Discussion tab when you
select  a  task.  Parent  workflow  tasks  and  their  subtasks  share  any  comments.
Therefore, the whole discussion history is shown in the Discussion tab of each task and
subtask within a workflow task.

You can add comments to any task or document  without  any limitations, provided that
you have access to this task or document. You can also add comments to Comindware-
enriched tasks within Microsoft Outlook.

To add a comment to a task or document:

1. Open the task or document on which to add your comment. 

2. Select the Discussion tab (for Microsoft Outlook tasks, Click the Discussion button in
the ribbon of the selected task).

3. Type-in your comment.

4. Click Save.

A notification will be sent  to users who follow this task. For Microsoft  Outlook tasks, a
notification will  be  sent  after  the  next  synchronization  between  Comindware  Tracker
and Microsoft Outlook is performed.

You can reply to any comment within any task or document you have access to.
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To reply to a comment:

1. Browse to the comment you wish to reply to. 

2. Click the Reply link beside the comment.

3. Type your reply into the comment box.

4. Click the Save  link beside the comment.  For Microsoft  Outlook tasks,  click Save  in
the Ribbon.

As soon as the comment  is saved, an e-mail  notification will  be  sent  to  the  author of
the comment and all followers of a task or document.

Exporting to Microsoft Word

You can export any Comindware task or document to a Microsoft Word file. This feature
may be useful if you need to:

print an invoice or an order to a customer;

create release notes for a new software release in a docx document,

create a project changelog.

To export a task or document into a Microsoft Word file:

1. In My Desktop, open a task or document. 

2. Click the Export to Word button.

A  Word  file  will  be  generated  and  downloaded  to  your  computer.  Depending  on  your
browser settings, you will either have to choose a local folder on your computer to save
the file to or it will be saved to a default download folder configured in your browser.

Creating a Task/Document By Sending An E-mail

Your tasks and items can be automatically created directly from e-mail  messages  sent
to  a  particular  e-mail  address  associated  with  a  task  group  or  an  item  group.  This
feature may be useful in a number of ways, for example:

your staff can e-mail hardware or software problems into your company’s Help Desk
department, and the e-mails will be converted into Help Desk Requests,

your  staff  can  send  document  preparation  requests  to  the  Human  Resources  or
Financial departments, and the e-mails will be converted into Document Requests.

external customers can e-mail problems to the Technical Support  Team, and the e-
mails will be converted into Support Incidents.

To send an e-mail:

1. Start  a  new  message  in  your e-mail  client.  For  example,  to  create  a  new  e-mail
message in Microsoft Outlook, open Microsoft Outlook and press CTRL+SHIFT+M. 

2. Enter  the  recipient  e-mail  address  in  the  To  box.  The  e-mail  address  should  be
associated  with  a  group  of  tasks  or  group  of  items  in  Comindware  Tracker.  This
should  be  previously  done  by  the  Comindware  administrator.  See  Comindware
Tracker Administrator's Guide. for details.

3. In  the  Subject  box,  type  the  subject  of  the  message.  The  e-mail  subject  will  be
converted to the name of the Comindware task or item.

http://dl2.comindware.com/pdf/Comindware_Tracker_Administrators_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_Tracker_Administrators_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_Tracker_Administrators_Guide_en_A4.pdf
http://dl2.comindware.com/pdf/Comindware_Tracker_Administrators_Guide_en_A4.pdf
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4. The  body  text  of  the  e-mail  message  will  be  converted  to  the  Description  of  the
Comindware task or item.

5. You  can  add  attachments  to  th  e-mail  message.  E-mail  attachments  will  be
converted into a Comindware task or item attachment.

6. Click Send. After the message has been sent, you will receive an e-mail notification
about the status of your e-mail.
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Searching For Tasks And Documents

Comindware Search allows you to quickly find your tasks and documents as well as any
task-related or document-related information.

To access search:

1. Locate your mouse cursor in the Search box in the right part of the Header. 

2. Enter your search criteria.

What you can search

You can search for the following information:

Task ID or document ID

title

any text in the Description and Discussion fields

any text in custom fields previously marked as Indexed while creating an application

Search by ID

Enter an ID or according to the following pattern: #1234, where 1234 is the ID of a task
or document.

Text search

Enter the text  in the  search box and  press  Enter  or press  the  search icon beside  the
search box.

Words ignored in search

The following words will be skipped over during your search:

"a", "an", "and", "are", "as", "at",  "be",  "but",  "by",  "for",  "if",  "in",  "into",  "is",  "it",  "no",
"not", "of", "on", "or", "such", "that", "the", "their", "then", "there", "these", "they", "this",
"to", "was", "will", "with".

Searching Inside Lists

You can search for any information within a particular list. 

Simply  type-in  the  information you would  like  to  search  in  the  inline  search  box  and
search results are instantly presented to you based on your partially typed query (filter
and find as you type).
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Search results
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Subscribing to Task/Document Notifications

You can follow  particular tasks  by  signing  up  for  e-mail  notifications  of  any  updates
related to a task or item. By default, you receive e-mail notifications from Comindware
Tracker if  you are a task assignee or a  person responsible  for an item step.  However,
you can become a follower of almost any task.

To  become  a  task follower,  select  a  task in  a  list  and  click the  Follow  button in  the
Ribbon.

Managing Followers

You can manage a list of followers of a task or document. Once a user has been chosen
as a follower or removed from a followers' list, they will receive an e-mail notification.

To edit a list of followers of a task or document:

1. Open a task or a document. 

2. Click the Manage Followers button.

3. Select a user to be added to, or removed from the list. To select multiple users, just
click on them.  Click a  user one  more  time  to  unselect.  Use  the  Add  and  Add  All
buttons to add users from the Available users box, and the Remove  and Remove  All
buttons to remove the selected users from the followers' list.

Adding users to the list of followers

4. When finished, click Save to apply changes.

Setting Up Personal Notifications

You  can  turn  personal  e-mail  notifications  on/off,  provided  that  the  Comindware
administrator has configured the outgoing e-mail server settings. You can enable/disable
auto following as well.

These settings can be changed from your profile.

To open your profile settings:

1. Click the Menu tab and go to the Your Profile  page, or click your Comindware profile
name in the header and then click Profile Settings. 

2. Choose  an  action  you  want  to  perform:  change  a  password  or  set  up  e-mail
notifications.
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Customizing your profile

Reducing the number of auto follow e-mails

If  a  task has  been assigned  to  you or you make  any  changes  to  a  task,  you  will  be
added to the followers list of this task automatically. To enable auto following, clear the
 Disable auto follow check box (selected by default).

Disabling e-mail notifications

You may not want to receive e-mail notifications when each of your tasks has changed.
In this case, select the option Turn off e-mail notifications (cleared by default).

Adding a due date reminder

If you want to be notified daily about your soon due and overdue tasks, select  the Start
receiving  daily  notifications when  a  task  is  about  to  expire  in  check  box  and  select  the
number of days.
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Real-Time Monitoring Tools

Chapter 5

This chapter includes the following topics:

Configuring lists

Configuring the dashboard

Automating reports
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Configuring Lists

Lists are created to help users sort, filter and manage tasks and documents.

Some  lists,  included  in  the  product  are  preconfigured  —  some  can  be  configured  by
administrators; — finally users  can create  their own unique  lists  themselves  and  even
share them with other users.

Lists are also used as a data source for building widgets.

Lists can be created  within  Comindware  applications  and  in  your personal My  Desktop
area. Lists can be shared between users.

Default Lists

Comindware Tracker provides default lists to better organize your tasks and documents.

Name Description

Personal Tasks Displays all your personal tasks.

My Team Active Tasks Displays active tasks assigned to your team members.

My Completed Tasks Displays your completed tasks.

All tasks I follow Displays  tasks  not  assigned  to  you,  or  tasks  of  other
users, the progress of which you follow,  i.e.  you clicked
the Follow button for a task.

Completed  delegated
tasks

Displays  tasks  that  you  created  and  assigned  to  other
users.  The  new  assignee  has  accepted  the  task  and
completed it.

Active delegated tasks Displays  tasks  that  you  created  and  assigned  to  other
users. The new assignee has accepted the task but  has
not yet completed it.

My Active Tasks Displays all your tasks assigned to you and  accepted  by
you, that have the Active status.

Each list can be marked as Favorite. Lists marked as Favorite appear at  the top of the
Navigation pane.
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Default lists

Creating a List

Lists are created per group by group Owners and group Members.

To create a new list:

1. In the My Desktop area select the List tab and click New List. 

2. Choose  what  type  of  information  you  want  to  include  in  your  list,  for  example,
personal tasks,  bugs,  claims,  etc.  You can select  several types  of  information  by
pressing and holding the CTRL or SHIFT key.

3. Choose one or more applications that will serve as a data source for the list.

Choosing data for your list

4. Click Next > to pass to the list configuration page.

5. Add  the  columns  you  want  to  be  added  to  the  list  by  dragging  them  from  the
Available Fields area to the Add Columns area.

6. Alternatively, you can configure the sort order and set  column grouping by dragging
and dropping them to the respective areas.
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Choosing columns, sort order, and grouping

7. Create a filter for the list: drag and drop the columns you want  to be filtered in the
Edit filter criteria area, and set a filtering parameter. You can use logical operators in
your filter, for example, “AND” and “OR”.

8. Click Save.

9. Specify  a  destination  for  the  list  (you  may  select  between  different  groups  you
have access to and your personal space  “My  Desktop”),  give  a  name  to  your list.
Alternatively, you can add the list to favorites or share the list  between other users
by selecting the Make Public checkbox.

Saving your list

Modifying List Settings

You can change  list  settings,  such as  filter criteria  and  grouping  options,  or you  can
create a new list based on the settings of an existing list.

To modify an existing list:

1. Select a list in the Navigation pane. 

2. Select the List tab, and click Edit.

3. Make changes to  the  list  settings,  such as  filter criteria,  number of  columns,  sort
order and grouping options.

4. Click Save  to save your changes in this list, or Save  As to  save  the  changes  as  a
separate list.
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Filtering Items In a List

Filtering by column values

You can filter items in a list  by a particular column value. For example, you may display
only tasks that have Medium priority.

To filter items by column values in a list:

1. Hover the mouse cursor over a column header, and click on Filter by 

2. Select one or more values you want to filter items by.

Showing tasks w ith Medium priority

Sorting items in a list

You can sort  data  in  ascending  or descending  order by  simply  clicking  on the  column
header.

Grouping items in a list

If Comindware built-in arrangements do not  provide the view you need, you can create
your own  grouping  levels  by  customizing  your  view.  Hover  the  mouse  cursor  over  a
column header and press on the Group By This Column drop-down button.

Tasks grouped by Due Date, subgrouped by Priority

Exporting To Microsoft Excel

You can export data in any list into a Microsoft Excel file.

To export a list into a Microsoft Excel file:

1. In My Desktop, click on the List tab. 

2. Select the list and click the Export to Excel button.

An Excel file  will  be  generated  and  downloaded  to  your computer (depending  on your
browser settings you will either have to select  a local folder on your computer to save
the file to or it will be saved to a default download folder configured in your browser).
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Organizing Favorites

Any  list  or  dashboard  can  be  marked  as  Favorite  for  quick  access.  Favorites  are
displayed  at  the  top  of  the  Navigation  pane  when  you  select  the  My  Desktop
workspace. The list  that  comes  first  in  Favorites  will  be  opened  by  default  each time
you  open  My  Desktop.  You  can  mark  a  list  or  dashboard  as  Favorite  in  one  of  the
following ways:

in the Navigation pane, click the star of the desired list or dashboard

select the Add to Favorites checkbox while creating a new list or dashboard

open any list not displayed in the Navigation pane, go to List Settings, and click Add
to Favorites

Adding a list to Favorites
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Configuring The Dashboard

Dashboard  is  a  customizable  environment  that  displays  information  through  a  set  of
widgets.  Dashboards  are  created  per  workspace  or  application.  A  dashboard  has  the
same security permissions as the application it belongs to.

A configured dashboard

You can also create personal dashboards — dashboards which will be  saved  in  the  My
Desktop area. A user can make a personal dashboard public. By default, each user has
their  own  personal  My  Dashboard  with  a  pre-configured  pie  chart  showing  a  user’s
active tasks filtered by status.

Default w idget in My Dashboard

To create a dashboard:

1. In My Desktop click on the Dashboard tab. 

2. Click the New Dashboard button in the Ribbon.

3. Select  an  application  where  you  want  to  save  the  list  or  dashboard,  specify  a
dashboard name and visibility settings: selecting the Add to Favorites check box will
add this dashboard to the Favorites area in My Desktop, selecting the Make  Public
check box will make this dashboard accessible to other users.

4. Click the Save button in the Ribbon. Now you can add widgets to the dashboard.



Comindware Tracker

82 www.comindware.com

Saving the dashboard

Adding And Configuring Widgets

Information about your tasks and documents is displayed on the dashboard through the
use of widgets. You can add a widget  to the dashboard and configure it  to display the
details you need. A widget can be added to the dashboard as many times as you need.

Each widget  is tied  to  the  selected  list.  All  widgets  have  a  number of  display  options
such as data grouping, filtering and data presentation.

Available widgets

The  following  widget  types  can be  added  to  a  dashboard.  The  number  of  widgets  is
unlimited.

Widget name Description

My  active  tasks
by status

A default  widget; shows how many  tasks  you
have in each status in the form of a Pie chart.

See My Active Tasks by Status .

Pie chart A  pie  chart  displays  value  data  as  a
percentage  of  a  total.  Consider  using  a  pie
chart  after the  data  has  been aggregated  to
seven data points or less.

See Pie chart .

Column chart A  column chart  displays  a  series  as  a  set  of
vertical  bars  grouped  by  category.  Column
charts  are  useful  for  illustrating  comparisons
between items.

See Column chart .

Created  Vs.
Closed

A  chart  showing  the  tasks  or  items  created
vs. closed over a given period of time.
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Widget name Description

See Created vs. Closed chart .

Bar chart A  bar  chart  displays  data  horizontally.  It  is
popular  for  categorical  information,  because
the categories can be displayed horizontally.

See Bar chart

History  Events
chart

Shows the different types of history events in
the form of a Column chart.

See History Events chart

Adding a widget in a dashboard

You can add any type of a widget in the dashboard.

To add a widget:

1. In the Navigation pane of the My Desktop area, select  a dashboard where you want
to add a widget. 

2. Click the Add Widget button in the Ribbon menu.

3. Select the widget type.

4. Select the list which will be used as a source for widget data.

5. Configure other widget settings.

6. Click Save. Your widget will be added to the dashboard.

Created vs. Closed Chart

The Created vs Closed chart shows the dynamics of daily opened and closed items. For
example, in a Customer Support  department  you can configure  the  widget  to  see  how
many claims you receive every day, and how effectively your team resolves them.
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The Created vs Closed chart

To create the Created vs. Closed chart:

1. Select a dashboard in the Navigation pane. 

2. Click the Add Widget button in the Ribbon.

3. Choose the Created vs. Closed widget type.

4. Select a list that will be used as the data source for your widget.

5. Complete  the  required  fields  of  the  Widget  Settings  page  as  shown  in  the  table
below:

Value Description

Widget name Widget  name will be displayed as a  title  for the  widget  in
the dashboard.

Data source A  list  of  tasks  or  items  used  as  a  data  source  for  this
widget.

Group  by  a  period  of
time

A time period according to  which the  values  of  indicators
in a chart will be grouped: by day, week, or month.

Cumulative total This option presents total items/tasks  accumulated  within
previous  time  period.  If  this  option  is  not  selected  the
actual  number  of  opened/closed  tasks  or  items  for  the
defined time period will be displayed.

Display  the  difference
between  open  and
closed  tasks  on  one
line

Select this option to see the graph showing the difference
between the number of created and closed tasks or items
over a period of time.

Display  open tasks  and
closed  tasks  on  two
lines

Select  this  option if  you  want  to  show  opened  tasks  or
items  on one  line,  and  closed  tasks  or  items  on  another
line.
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6. When finished, click the Finish button. The widget will be added to your dashboard.

History Events Chart

The History Events chart  shows the work progress on tasks  by  a  particular event,  for
example step changed, or item opened or closed.

History Events w idget

To create the History Events chart:

1. Select a dashboard in the Navigation pane. 

2. Click the Add Widget button in the Ribbon.

3. Choose the type of History Events widget.

4. Select a list that will be used as the data source for your widget.

5. Complete  the  required  fields  of  the  Widget  Settings  page  as  shown  in  the  table
below:

Value Description

Widget name Widget  name will be displayed as a  title  for the  widget  in
the dashboard.

Data source A list of tasks used as a data source for this widget.

Event Created, Updated, Deleted, Commented,  Comment  Edited,
Closed. Step Changed

Group  By  a  Period  of
Time

A time period according to  which the  values  of  indicators
in a chart will be grouped: by day, week, or month.

6. When finished, click the Finish button. The widget will be added to your dashboard.
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Pie Chart

A pie chart  illustrates how different  parts of  work contribute  to  the  overall  result.  For
example, the number of critical bugs and normal bugs for a release.

Pie chart

To create a Pie chart:

1. Select a dashboard in the Navigation pane. 

2. Click the Add Widget button in the Ribbon.

3. Choose the type of Pie chart widget.

4. Select a list that will be used as the data source for your widget.

5. Complete  the  required  fields  of  the  Widget  Settings  page  as  shown  in  the  table
below:

Value Description

Widget name Widget  name will be displayed as a  title  for the  widget  in
the dashboard.

Data source A  list  of  tasks  or  items  used  as  a  data  source  for  this
widget.

Group by 1 Choose a field in which you want  to  combine  data  into  a
single sector.

Data  grouping  inside
sector

Choose  how  to  group  data  inside  sectors.  The  following
values are available:

Count

Max

Min

Sum

6. When finished, click the Finish button. The widget will be added to your dashboard.
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Column Chart

A column chart displays data as a set  of vertical bars grouped by category. It  is useful
for illustrating comparisons among items.

Column chart

To create a Column chart:

1. Select a dashboard in the Navigation pane. 

2. Click the Add Widget button in the Ribbon.

3. Choose the type of Column chart widget.

4. Select a list that will be used as the data source for your widget.

5. Complete  the  required  fields  of  the  Widget  Settings  page  as  shown  in  the  table
below:

Value Description

Widget name Widget  name will be displayed as a  title  for the  widget  in
the dashboard.

Data source A  list  of  tasks  or  items  used  as  a  data  source  for  this
widget.

Group by 1 Choose a field in which you want  to  combine  data  into  a
single sector.

Group by 2 Choose a field in which you want  to  combine  data  into  a
single sector.

Stacked Columns  will  be  placed  on  top  of  each  other  to  make  a
single column.

Data  grouping  inside
sector

Choose how to group the data in the sector.

6. When finished, click the Finish button. The widget will be added to your dashboard.
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Bar Chart

A  bar chart  allows  you to  show  tasks  sorted  by  status,  for  example,  the  number  of
tasks and their statuses per each release.

Bar chart

To create a Bar chart:

1. Select a dashboard in the Navigation pane. 

2. Click the Add Widget button in the Ribbon.

3. Choose the type of Bar chart widget.

4. Select a list that will be used as data source for your widget.

5. Complete  the  required  fields  of  the  Widget  Settings  page  as  shown  in  the  table
below:

Value Description

Widget name Widget  name will be displayed as a  title  for the  widget  in
the dashboard.

Data source A  list  of  tasks  or  items  used  as  a  data  source  for  this
widget.

Group by 1 Choose a field in which you want  to  combine  data  into  a
single sector.

Group by 2 Choose a field in which you want  to  combine  data  into  a
single sector.

Stacked Bars will be placed side by side to make a single bar.

Data  grouping  inside
sector

Choose how to group the data in a sector.

6. When finished, click the Finish button. The widget will be added to your dashboard.
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My Active Tasks by Status

Each Comindware  user has  a  default  dashboard  called  'My  Dashboard',  which  is  pre-
populated  with  the  'My  Active  Tasks  by  Status'  widget.  This  widget  shows  which  of
your tasks are not closed. These are grouped by task status in the form of a pie chart.

The "My Active Tasks by Status" w idget

To open the "My Active  Tasks  by  Status" widget,  find  My  Dashboard  in  the  Favorites
area of the Navigation pane and click on it.

Displaying The Dashboard In The Full Screen Mode

Full screen dashboards help you visualize what’s going on in the business. For example,
a full screen dashboard can be displayed on a large LCD panel in your meeting room to
show interactive project statistics to all team members.

To open a dashboard in the full screen mode:

1. Select a dashboard in the Navigation pane. 

2. Click the Full Screen button in the Ribbon.

3. Press the F11 key to make your web browser full screen.

4. If necessary, increase or decrease the auto-refresh time interval (in minutes).

To exit  the full-screen mode, click the Exit button,  and  press  the  F11 key  to  exit  the
full-screen mode in your browser if you previously enabled it.
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Dashboard in the full-screen mode

Deleting The Dashboard

You can delete  the  dashboard  and  its  widgets.  Deleting  a  dashboard  does  not  delete
the data it shows. The deleted dashboard cannot be restored.

To delete the dashboard:

1. In the Navigation Pane of the  My Desktop  area,  select  the  dashboard  you want  to
delete. 

2. Click the Delete button in the Ribbon.
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Automating Reports

This chapter includes the following topics:

Prerequisites

About scheduled reports

Who is a Report Owner

Creating an automated scheduled report

Prerequisites

Who can perform this operation

Scheduled reports can be created by any Comindware users who have the Comindware
Tracker Full license assigned by Comindware administrator.  Users  with  the  Comindware
Tracker Requestor license cannot create reports.

About Scheduled Reports

Automated  reporting  allows  any  interested  people  (e.g.  team manager  or  customers)
see the exact status of your tasks and items at any point of time.

In Comindware Tracker automated reporting means that  you schedule list  creation and
delivery to particular users on a  regular basis.  E-mail  recipients  will  receive  the  e-mail
which will contain tasks and documents included in the list.

Who is a Report Owner

A  report  owner  is  a  Comindware  Tracker  user  on  behalf  of  which  the  report  was
created. Information included  in  the  report  depends  on a  permission level assigned  to
the report  owner. If the report  owner has  Owners  or Members  permissions,  the  report
will contain all the data. If the report owner has Viewers or Requestors permissions, the
report may miss some data.

Creating an Automated Scheduled Report

To create a scheduled report:

1. Select a list in the Navigation pane. The list will be opened in the list pane. 

2. Click the List tab, click the Schedule Report Delivery button.

3. Specify  how  often  to  send  the  report  (Daily,  Weekly,  Monthly,  Yearly),  and  then
select options for the frequency.

4. In the Delivery time box, specify the delivery time of the report and the time zone.

5. In the E-mail  recipients box, specify the e-mail addresses of users  whom you want
to receive this report. Use semicolons ( ; ) to separate e-mail addresses.

6. When finished, click OK.
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Scheduling a report

To change an existing report schedule:

1. Select a list scheduled to be sent as a report. 

2. Click the List tab, click the Change Send Report Options button.

3. Modify send report settings: send schedule, send time, e-mail recipients.

4. When finished, click OK.

To cancel send report schedule:

1. Select a list scheduled to be sent as a report. 

2. Click the List tab, click the Change Send Report Options button.

3. Click the Disable Schedule button.
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Microsoft Outlook Integration

Chapter 6

This chapter includes the following topics:

About Microsoft Outlook tasks and Comindware tasks integration

Installing and configuring Comindware Tasks for Outlook

Creating a task in Microsoft Outlook

Synchronizing tasks
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About Microsoft Outlook Tasks And
Comindware Tasks Integration

You can work with  your Microsoft  Outlook tasks  in  Comindware  Tracker  and  you  can
manage all your Comindware tasks within Microsoft Outlook.

The  Comindware  Tasks  for  Outlook  module  synchronizes  Comindware  tasks  and
Microsoft  Outlook tasks,  and  enhances  Microsoft  Outlook tasks  with  extra  features  of
Comindware tasks:

adding comments and threaded discussions;

creating multiple subtasks within a task;

accepting/declining tasks;

sorting tasks by task applications.

Microsoft  Outlook  tasks  enhanced  with  Comindware  Tracker  functionality  are  called
Comindware-enriched tasks.

Comindware-enriched Task tab
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Installing And Configuring Comindware Tasks
for Outlook

To  enable  such  type  of  task  management  you  need  to  install  Comindware  Tasks  for
Outlook onto your desktop or laptop computer with Microsoft Outlook installed.

Obtaining The Installation File

The  Comindware  Tasks  for  Outlook  installation  file  can  be  obtained  directly  from
Comindware Tracker. Click the Menu tab, and then in the Welcome page, click the  Get
Comindware Tasks for Outlook link.

Obtaining the Comindware Tasks for Outlook installation file

Installing Comindware Tasks For Outlook

Comindware Tasks for Outlook should be  installed  on your desktop  or laptop  computer
where you have Microsoft Outlook 2010 installed.

To install Comindware Tasks for Outlook:

1. Launch the downloaded file ComindwareTasksForOutlook.exe. 

2. Go through the Installation Wizard setup steps and click Install.

3. After the installation is finished, launch Microsoft  Outlook. You will  be  prompted  to
configure the synchronization parameters.

Uninstalling Comindware Tasks For Outlook

You  can  uninstall  Comindware  Tasks  for  Outlook  if  you  do  not  need  it.  During
uninstallation,  all  tasks  will  be  deleted  from  Microsoft  Outlook,  but  will  remain  in
Comindware Tracker.
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Configuring Synchronization Settings

After  Microsoft  Outlook  has  been  launched,  you  will  be  asked  to  configure  the
synchronization parameters. You can modify  them later,  for example,  by  changing  the
sync interval or connecting to another Comindware Tracker.

To configure synchronization settings:

1. Launch Microsoft Outlook. 

2. Go to File > Options > Add-Ins.

3. Choose Comindware  Tasks for Outlook from the list  of  add-ins,  and  click the  Add-In
Options... button. Alternatively, you can click the Comindware tab in the ribbon, and
then click the Options button.

Choosing Comindware Tasks for Outlook from the list of add-ins

4. Click Add  to  add  a  new  account.  Click  Change  if  you  already  have  a  configured
account and would like to change its settings.

Setting up synchronization parameters

5. Configure the following settings:
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Name Description

Account Enter your Microsoft  Exchange e-mail account. The same  e-
mail  account  must  be  registered  in  Comindware  Tracker.
Currently Comindware Tasks for Outlook cannot  handle  more
than one Microsoft Exchange account.

Exam ple: yournam e@ yourcom pany.com

URL address The  URL  address  of  your  Comindware  Tracker.  The  URL
should start with http:// or https://.

Exam ple: h ttp://yourbugtracker.yourcom pany.com .

Password Enter the password of your Comindware account.

Sync  Interval
(min)

Enter  the  sync  interval  (in  minutes)  between  Microsoft
Outlook  and  Comindware  Tracker.  The  sync  interval  value
may  be  set  between  15  and  10080  minutes.  The  minimum
value is set by default.

Default  tasks
app

Default tasks app for new tasks. This list is unavailable during
installation  and  becomes  available  after  the  first
synchronization  with  your  Comindware  product.  By  default,
the Personal Tasks group is set.

6. Click Test to check if the settings you've specified are correct.

Configuring the synchronization

parameters

7. Click OK to save the settings.
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Creating a Task In Microsoft Outlook

To create a task in Microsoft Outlook 2010:

1. Open Microsoft Outlook. 

2. Click the Home tab and click New Items and select Task.

Creating a task in Outlook

3. Set your name and options.

4. Click Save & Close.
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Synchronizing Tasks

Comindware Tasks for Outlook monitors task changes  in  both Comindware  Tracker and
Microsoft Outlook. As soon as you have created a task, or saved changes in an existing
task, or someone assigned a task to you,  the  tasks  will  be  synchronized  between the
two programs.

Synchronization is performed automatically in accordance with a specified sync  interval
to keep your tasks up to date across both applications.

In  addition  to  automatic  synchronization,  if  you wish to  send  the  changes  you  made
immediately,  you can run synchronization manually  by  clicking  the  Send/Receive  Tasks
button in the Comindware tab in Microsoft Outlook.

The maximum number of tasks synchronized at a time is limited to 500.
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Administering Comindware Tracker

Chapter 7

This chapter includes the following topics:

Before you begin

Managing product licenses

Managing users and user groups

Creating Requestor workspace

Configuring outgoing e-mail settings

Configuring Comindware Tracker to create items from e-mails

Adding a custom logo

Backing up the Comindware database

CSV Import

Microsoft SharePoint Integration

Enabling single sign-on
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Before You Begin

This chapter includes the following topics:

Who can configure Comindware Tracker

Opening Comindware Tracker

Exploring the Administration area

Who Can Configure Comindware Tracker

Comindware  Tracker  configuration  is  performed  by  users  who  have  Comindware
administrator or Comindware architect privileges.

Name Default privilege level

Comindware
administrators

have  full  control  over  Comindware  applications.  Generally
Comindware  administrator privileges  are  granted  to  a  system
administrator. Administrator-specific functions include:

Comindware Tracker installation,

performing post-installation setup,

managing local users and local user groups,

connecting Comindware Tracker to Active Directory,

connecting to incoming and outgoing mail servers,

creating backups of the Comindware database,

adding a custom company logo.

Comindware administrators also have full architect privileges.

Comindware
architects

perform setup of the work environment. Generally  Comindware
architect  privileges are granted to  team managers.  Architect-
specific functions include: 

creating and modifying workspaces,

creating and modifying applications,

creating and modifying workflows.

The first  Comindware administrator account  is  created  during  the  Comindware  Tracker
installation procedure. Later the Comindware administrator assigns the administrator and
architect  privileges  to  other  users  by  adding  the  users  into  the  Administrators  of
Architect user groups. See Editing user group membership .

Opening Comindware Tracker

To  configure  Comindware  Tracker you need  to  connect  to  Comindware  Tracker  using
Comindware  administrator  or  Comindware  architect  credentials.  Minimum  screen
resolution should be 1024 X 768 pixels.

To open Comindware Tracker:
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1. Open the web browser. 

2. In the address bar of your web browser, type the Comindware Tracker URL: 

http://ComputerName:Port, where:

Parameter Description Values

http:// data  transfer  protocol
specified during installation

http://

https://

ComputerName the  name  of  the  server
hosting  your application.  This
may  be  a  computer  IP
address,  or  a  computer  DNS
name.

localhost

127.0.0.1

LocalComputerName

RemoteComputerName

Port the port number specified
during installation

8081 (default for Comindware
Tracker installation)

80 (default for http
installation)

443 (default for https
installation)

Exam ple:  ht tp://loc alhost ,  ht tp://127.0.0.1,  ht tp://m ylaptoppc ,  ht tps://
bugt rac ker:8081

3. On the  login  page,  enter the  Comindware  administrator login  credentials  and  click
the Log In button.

The login page

Exploring The Administration Area

After  you  log  in,  go  to  the  Administration  page  by  clicking  the  Administration  icon
located to the left of the search box in the program header:
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Navigating to the Administration page

After  you  click  the  Administration  icon,  you  will  be  redirected  to  the  Administration
page:

The Administration page



Comindware Tracker

104 www.comindware.com

From the  Administration  page  you  configure  Comindware  Tracker  using  the  following
tools:

System settings setup tools:

Backup Management Create backups of the Comindware database,
view or delete backups. 

See Backing up the Comindware database

License Manager Add a new license, activate your license online or
manually, manage license assignment, delete a
license.

See Managing licenses

E-mail Notifications Configure MS Exchange or SMTP server settings
to allow sending e-mail notifications. 

See Configuring outgoing e-mail settings

Create Items by E-mail Configure e-mail accounts to create tasks and
items via e-mail.

See Configuring Comindware Tracker to create
items from e-mails

Custom Logo Add your company logo into Comindware Tracker,
add a favicon in the address bar of your browser.

See Adding a custom logo

Requestor Workspaces Create a work area for users who own the
Comindware Tracker Requestor license.
Requestors can only create items of a particular
type and view items created by them.

See Creating Requestor workspaces

Comindware Workflow for
SharePoint

Integration  of  Microsoft  SharePoint  with
Comindware  Tracker.  Work  with  Comindware
Tracker  workflows  directly  from  Microsoft
SharePoint.

See Comindware Workflow for SharePoint

CSV Import Migrate data from other issue tracking systems or
databases, update existing Comindware Tracker
items using a Comma Separated Values (CSV) file.

See CSV Import

User management tools:

Users Add new user accounts, edit user information,
deactivate user accounts. Manage privileges
assigned to users.

131

106

120

123

128

117

137

135



Adminis tering Comindware Tracker

Copyright © Comindware, 2009-2013 105

See Managing local users

User groups Add new user groups and new members to
existing groups. Manage group members, manage
group privileges. Manage Comindware
administrators and Comindware architects groups.

See Managing local user groups  

Active Directory
Integration

Connect to the Microsoft  Active Directory server,
import user profile information.

See Connecting to Active Directory  
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Managing Product Licenses

This chapter includes the following topics:

Prerequisites

Comindware license types

Entering product keys and activating the product

Assigning users to the product key

Prerequisites

Who can perform license management

Comindware administrators

Preliminary steps

No preliminary steps required to perform actions with licenses.

Comindware License Types

Comindware  Tracker  can  be  purchased  as  an  on-premise  software  or  as  a  cloud
subscription based service.

To obtain any type of on-premise license or cloud subscription, you need to register an
account  on  the  Comindware  web  site  at  http://www.comindware.com and  receive  a
product key from your account.

On-Premises Licenses

To  use  the  on-premises  version  of  Comindware  Tracker,  you  will  need  at  least  one
Comindware Tracker Full license and (optionally) Comindware Tracker Requestor license.

Comindware Tracker Full License

Comindware  Tracker  Full  License  provides  unlimited  access  to  all  features  and
capabilities  of  Comindware  Tracker,  including  working  with  tasks,  workflows,
collaborative features, reports and dashboards.

Comindware Tracker Requestor License

Comindware Tracker Requestor License provides  limited  access  to  Comindware  Tracker
features and capabilities.  This  type  of  license  is  designed  for those  users  who  submit
requests  like  Purchase  Requests,  IT  Help  Desk  Tickets,  Vacation  Requests,  etc.  and
need to track their request progress.

Difference Between Full License and Requestor License
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Actions Full
License

Requestor
License

Submit requests • •

Collaborate on requests • •

Get status notifications • •

Manage requests submitted by other users • •

Manage tasks • -

Design workflow processes • -

Configure  personal  Workspace  (the  My
Desktop area)

• -

Real-time  monitoring  with  dashboards  and
lists

• -

Use Comindware Tasks for Outlook • -

Team collaboration • -

Comindware Tracker Trial License

The  Comindware  Tracker  trial  license  allows  you  to  evaluate  the  full  functionality  of
Comindware  Tracker for free  during  a  30 day  trial  period.  You  can  also  use  the  trial
cloud based subscription service  to  evaluate  Comindware  Tracker.  Trial  subscription is
free and is valid for 30 days.

Comindware Cloud Service Subscriptions

Comindware Tracker can be used as a Cloud  subscription-based  service.  Cloud  service
provides exactly the same functionality as on-premises Comindware Tracker installation.

Trial Subscription

You can evaluate the full functionality of Comindware Tracker for free during a  30 day
trial  period.  Once  your  trial  period  is  over,  the  Comindware  Tracker  features  will  be
locked,  but  your  data  will  be  kept  within  2  weeks.  If  you  do  not  purchase  the  Full
license or subscription within a trial  period  or after two  weeks  after the  trial  period  is
over, your data will be deleted.

Full Subscription

Comindware Cloud Service Full Subscription is available for one month and for one year.
You can purchase the subscription at: http://www.comindware.com/buy/.

http://www.comindware.com/buy/
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Upgrading from trial subscription to full license or full subscription

When  the  trial  subscription  is  over,  you  can  purchase  either  full  subscription  and
continue  using  Comindware  as  a  cloud-based  service,  or  purchase  the  Comindware
Tracker Full  license  for on-premises  Comindware  Tracker installation.  If  you  choose  a
cloud-based  service,  your  data  created  during  the  trial  period  will  be  seamlessly
migrated to  your full  subscription.  If  you choose  the  on-premises  installation,  you will
need to contact  the Comindware support  team to  migrate  your cloud  data  to  the  on-
premises installation.

Entering Product Keys And Activating The Product

After installation of Comindware Tracker, you need to enter a product  key. As soon as
you enter your product key, Comindware Tracker will automatically be activated on the
Comindware  web  site.  Before  activation,  make  sure  an  Internet  connection  is
established and you've  already  registered  an account  on the  Comindware  web  site  at
http://www.comindware.com/my-account.

To add a product key and activate Comindware Tracker:

1. Open Administration > License Manager. 

2. Click the Add Product Key button.

3. Enter  your  64-digit  product  key.  You  can  enter  several  product  keys  at  once
delimited by the <Enter> key.

4. Click Activate.

Adding product keys

After the keys are added, you might need to refresh the page to update the information
by pressing F5.

Product  keys  are  language  specific.  You  will  not  be  able  to  add  a  product  key  for
another language if you have already entered a product key.

Manual activation

You can use manual activation if  the automatic  activation fails or if  you don't  have  an
Internet connection on the server.

To manually activate the product:

1. Open Administration > License Manager. 

2. Click the Add Product Key button.

3. Click on the Manual Activation link.

http://www.comindware.com/my-account
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4. Retrieve the Installation ID file by clicking Get File. Save the  file  to  your computer
(default file name: ActivationRequest.txt).

Manual Activation

5. Open  your  Comindware  account  on  the  Comindware  web  site  at  http://www.
comindware.com/my-account/, and upload the Installation ID file.

6. Get  the file  with  your activation code  from your Comindware  account  (default  file
name: ActivationResponse.txt).

7. Click the Upload button in the Manual Activation window to upload the file containing
your activation code.

Assigning Users To The Product Key

Each Comindware Tracker product key should be assigned to one or more users.

To assign users to a product key:

1. Open Administration > License Manager. 

2. Select the Comindware Tracker product key you want to assign.

3. Click Manage Keys.

4. Click Assign Users in the left part of the window.

5. Select the user who will be assigned to this product key.

6. Click Save.

Assigning users to the product key

http://www.comindware.com/my-account/
http://www.comindware.com/my-account/
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Managing Users And User Groups

This chapter includes the following topics:

Prerequisites

Managing local users

Managing local user groups

Adding users and user groups from Active Directory

Adding an external user

Prerequisites

Who can perform this operation

Comindware administrators

Preliminary steps

Comindware Tracker Full license added 

Managing Local Users

Comindware  Tracker  keeps  users  and  user  groups'  information  on  its  own  account
information database.  You can manage  users  and  user groups  directly  in  Comindware
Tracker or update with user accounts and groups of an LDAP-based directory server in
a domain, for example, Active Directory. You can use the mixed mode: some users can
be taken from Active Directory, some users can be created locally.

List of users

Creating a Local User

Use  local  authentication  if  your  company  does  not  use  Microsoft  Active  Directory
server, or if  you want  to give access to an external user who does not  belong to your
corporate domain.

To create a local user:
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1. Go to Administration > Users. 

2. Click New User in the Ribbon.

3. In the Login Name and Password fields, provide user credentials, required for logging
into Comindware Tracker.

4. Enter  user  details:  full  name,  e-mail,  IM  addresses,  mobile  and  business  phone
numbers, and other required information.

5. Select  the  External  user  check  box  if  your  Comindware  Tracker  is  connected  to
Active Directory and the user being added is not  a member of a domain and  is  not
included into Active Directory.

6. In  the  Membership  section,  include  a  user  into  one  or  more  user  groups,  or  add
subordinates.

7. Click Save.

User Information

Adding a Local User Into a User Group

When a user is created, they can be added into one or more user groups. Membership in
a user group does not  affect  user roles and the  set  of  permissions,  unless  the  user is
included into Comindware administrators and Comindware architects groups.

Adding into user groups is performed by Comindware administrators.

To add one or more users into a user group:

1. Go to Administration > Users. 

2. Double-click on the user, then click Member Of.

3. Select one or more groups where you want to add the user.

4. Click Save & Close.

Deactivating a Local User

Deactivating a user means that  a user will not  be able to log in,  though their personal
information and all their activities, files, history, and other information will be kept  in the
system. At any moment you can reverse this change and reactivate the user account.

To  deactivate  a  local user,  go  to  Administration  > Users,  select  a  user and  clear  the
Active check box.
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Deleting a User

Deleting a local user will delete the user account  information. User information in  tasks
and  items  related  to  the  deleted  user  will  be  shown  as  Name.Surname  (Deleted).
However, the administrator will be able to create a new user with such a login name.

To delete a local user, go to Administration > Users, select the user and click the Delete
User button.

Managing Local User Groups

Users can be  organized  into  user groups.  Organizing  users  into  user groups  facilitates
the management of multiple users. User groups allow you to assign equal privileges to a
group of  users.  Each user can belong  to  several user groups.  Besides  users,  you can
add user groups into other user groups. When a user group is added into another one, it
inherits the privileges of its parent group. You can only limit subgroup privileges, but you
cannot assign extra privileges that do not belong to a parent group.

Default User Groups

The following table shows default user groups and their privileges:

Name Default Privilege Level

Administrators have full control over Comindware  applications.  Administrator-
specific  functions  include  product  installation  and  performing
post-installation setup:

managing local users and local user groups,

connecting Comindware Tracker to Active Directory,

connecting to incoming and outgoing mail servers, 

creating backups of the Comindware database,

adding a custom company logo.

Comindware administrators also have full architects privileges.

Architects perform setup  of  the  work  environment:  create  workspaces,
applications, create and modify workflows.

Default user groups cannot be deleted.

User groups
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Creating a User Group

To create a user group:

1. Go to Administration > User Groups. 

2. Click New user group in the Ribbon.

3. Provide a name and a description for the user group.

4. In the Membership section, select  one of  the  following:  Parent  Groups,  Subgroups,
or Users.

5. Select  a  user/user group  to  be  added  to,  or  removed  from the  group.  To  select
multiple users and groups, hold down the control key as you click users  or groups.
Use the Add and Add All  buttons to add users/groups from the  Available  users and
groups box, and the Remove and Remove All buttons to remove the selected users/
groups from the Group Members box.

6. When finished, click Save & Close.

Editing User Group Membership

You can add extra users and user groups to an existing user group, or remove them. For
example, you can assign Comindware administrator or Comindware architect privileges to
users who will perform configuration of the  work environment  by  adding  them into  the
Administrators or Architects group.

To edit membership:

1. Go to Administration > User groups. 

2. Click on the user group you want to modify.

3. In the Membership section, select Parent Groups, Subgroups, or Users.

4. Select  a  user/user group  to  be  added  to,  or  removed  from the  group.  To  select
multiple users and groups, hold down the control key as you click users  or groups.
Use the Add and Add All  buttons to add users/groups from the  Available  users and
groups box, and the Remove and Remove All buttons to remove the selected users/
groups from the Group Members box.

5. When finished, click Save to apply changes.

User group membership
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Deleting a User Group

As  a  Comindware  administrator,  you  can  delete  any  Comindware  user  group  except
default  user  groups  (Administrators  and  Architects),  and  Active  Directory  groups.
Deleting a user group does not delete the users contained in this group. A deleted user
group cannot be restored.

To delete a user group:

1. Open the list of user groups. 

2. Select the check box of the user group you want to delete.

3. Click the Delete Group button.

Adding Users And User Groups From Active Directory

You can import  user profile  information from the  Microsoft  Active  Directory  service  if
your company  uses  Active  Directory  in  your domain.  This  saves  time  in  entering  user
information for every user in your organization.

Connecting To Active Directory

To import users and user groups from Active Directory, you should first  connect  to your
Microsoft Active Directory service.

To connect to Active Directory:

1. Go to Administration > Active Directory Integration. 

2. Select the Enable AD Integration check box.

3. Fill in the following server settings:

Name Description

Host name Provide  the  hostname  or  the  IP  address  of  your  domain
controller.

Exam ple: corp.m ycom pany.com .

Base DN Set  the starting point  of a  search in  Active  Directory.  If  no
base  DN is  specified,  the  search  starts  at  the  root  of  the
directory tree.

Exam ple: CN=Users ,DC=corp,DC=m ycom pany,DC=com

User name Enter a username to log in to the Active Directory server.

Password Enter  a  password  for  the  account  used  to  log  in  to  the
Active Directory server.

Auto Poll Select  the  check  box  to  schedule  automatic  polling  to  run
automatically at a specified interval.

Poll Interval Specify  your custom poll  interval (in  minutes),  or leave  the
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Name Description

default value. By default the poll interval is 10 minutes.

4. Click Save to save changes.

Configuring Active Directory settings

Verifying Connection Settings

Click the  Test  connection  button in  the  Ribbon  to  check  your  connection  settings.  If
connection fails, check if all your settings are correct.

Importing User Groups From Active Directory

When you have configured Active Directory settings, you can get the list of user groups
from the Active Directory server.

During import, user information is taken from the directory server and recorded into the
Comindware  database;  no  changes  are  made  to  the  directory  server.  New  user
accounts  that  exist  in  Active  Directory  will  be  added  into  the  Comindware  database,
however the information about existing users will not be updated.

To import users from Active Directory:

1. Go to Administration > Active Directory Integration. 

2. Click the Get AD Groups button in the Ribbon.

3. Create  a  group  mapping  between  Comindware  user  groups  and  Active  Directory
groups: select  the check box beside the user group that  you want  to be added  to
the Comindware database.

Selecting user groups to import

from Active Directory

4. Click  Save  and  Get  Groups  Now  to  update  the  Comindware  user  database  with
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directory server user accounts.

Importing a Particular User From Active Directory

You may want  to  import  a  particular user account  from the  Active  Directory  server if
the  user  is  not  a  member  of  any  group  in  Active  Directory.  During  import,  user
information  is  taken  from  the  directory  server  and  recorded  into  the  Comindware
database. The imported user account  won't  be added to any Comindware user groups,
you should add the user to the required groups manually.

To import a user account from Active Directory:

1. Go to Administration > Active Directory Integration. 

2. Click the Get AD User button in the Ribbon.

3. Type a valid domain user name and click Import.

Importing a user from Active

Directory

Adding An External User

An external user is a user who does not have access to your company domain, but  who
you allow to access your Comindware Tracker. For example, an external user may be a
client or a remote employee.

The single sign on feature is not available for external users.

To add an external user:

1. Go to Administration > Users. 

2. Click New User in the Ribbon.

3. In the Login Name and Password fields, provide user credentials, required for logging
into Comindware Tracker.

4. Enter  user  details:  full  name,  e-mail,  IM  addresses,  mobile  and  business  phone
numbers, and other required information.

5. Select the External User check box.

6. Click Save.
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Creating Requestor Workspace

This chapter includes the following topics:

Prerequisites

About Requestor Workspaces

Creating Requestor Workspace

Prerequisites

Who can create and configure Requestor workspaces

Comindware architects or Comindware administrators

Preliminary steps

Comindware  Tracker  Full  license  added,  Comindware  Tracker  Requestor  license
added 

Users and user groups added

Product  keys  for  Comindware  Tracker  Full  license  and  for  Comindware  Tracker
Requestor license assigned to users

Application created

About Requestor Workspaces

You  can  create  a  special  workspace  for  Comindware  users  who  do  not  have  the
Comindware Tracker Full license assigned, but  who have to create tasks or documents
in Comindware Tracker. Such users are called Requestors. In the  Requestor workspace
Requestors  can create  tasks  in  particular  applications  and  manage  tasks  created  by
them.  Requestors  have  their  own  type  of  license  —  Comindware  Tracker  Requestor
license, which is much cheaper than the Comindware Tracker Full license.

Requestor workspace benefits

no  need  to  purchase  extra  Comindware  Tracker  Full  licenses  for  Requestors.
Requestors do not use the full functionality of Comindware Tracker.

set up a custom view for items for Requestors.

hide some information from Requestors, for example, budgeting spent  on a particular
task.

Use Cases

Implementing  the  Help  Desk  Service  request  processing  process.  Your  company
employees create a Help Desk ticket in the Requestors page and tracks its progress.

Implementing  electronic  document  management  process.  Your  company  employees
create  document  preparation  requests  to  the  Human  Resources  or  Financial
departments, for example, a Vacation Request or W2 Form Request.
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Creating a Requestor Workspace

Requestor workspace creation process includes the following steps:

Specify general settings, i.e. page URL, page name and description,

Add Comindware Tracker applications, in which Requestors will create requests,

Configure the field set on the Requestor workspace and field visibility settings.

To create a Requestor workspace:

1. Go to Administration > Requestor Workspace. 

2. Click New Page.

3. Specify  page  general settings.  In  the  left  part  of  the  window  that  opens,  select
General > Page Information, enter page details:

Value Description

Page title Enter  a  custom  name  for  the  page.  Page  title  is
shown at the top of the Requestor workspace.

Exam ple: Help Desk Reques ts

Description Provide  a  description  of  the  Requestor  workspace.
Workspace description is displayed at  the top  of  the
page under the page title.

Exam ple:  Subm it  your  Reques t  to  the  Techn ical  Support
Team  in  case  of  hardware,  s oftware  ins tallation  is sues ,
s oftware reins tall/repair reques ts .

Internal URL Specify  the  Internal ID of  the  page.  Internal  ID  will
be added to your Comindware Tracker URL.

Exam ple: supportreques ts

Full URL In this field you will see how page URL will look like in
the address bar of a browser. Full URL consists of the
URL of your Comindware  Tracker installation and  the
internal URL.

Exam ple:  h ttp://www.com panytracker.com /
supportreques ts

4. Add applications in which requestors will create tasks or documents. In the left  part
of the window go  to  General  > Applications,  select  applications.  Use  the  Add  and
Add  all  buttons  to  add  the  selected  apps,  or Remove  and  Remove  All  buttons  to
remove the apps.

5. Specify  visibility  settings  for each  field.  In  the  Customize  Settings  item select  an
application, choose a field name and specify its settings:

Value Description

Read Only Requestors will not be able to modify this field.
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Invisible The field will not be shown to Requestors.

Editable Requestor can change the value of the field.

6. Set  the  field  order  in  the  web  form.  Select  the  field,  click  and  hold  left  mouse
button and drag the field upward or downward.

7. When finished, click Save or Save & Close.
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Configuring Outgoing E-mail Settings

This chapter includes the following topics:

Prerequisites

Connecting to SMTP

Connecting to Microsoft Exchange Server

Prerequisites

Who can configure outgoing e-mail settings

Comindware administrators

Preliminary steps

Comindware Tracker Full license added 

Users and user groups added

Product keys for Comindware Tracker Full license assigned to users

Connecting To SMTP

Connecting Comindware  Tracker to  a  corporate  e-mail  server will  allow  sending  e-mail
notifications  to  Comindware  users  when  particular  events  occur  with  tasks  or
documents, and sending scheduled e-mail reports to report recipients.

To connect Comindware Tracker to a company's SMTP server:

1. Go to Administration > E-mail Notifications. 

2. Select the Enable Outgoing E-mail check box.

3. Choose SMTP as the e-mail server type.

4. Specify the following SMTP server details as specified in the table:

Value Description

Host Name Specify  the  full  URL  or  IP  address  of  your  SMTP
server

Exam ple: sm tp.yourcom pany.com

Port Number Leave blank for default  (port  25 for SMTP) or specify
your value.

Timeout Specify  the  timeout  period  in  seconds.  By  default,
the timeout is set to 10 seconds.

From address E-mail address that  appears in the  "From" field  of  all
e-mail messages sent by Comindware Tracker.
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Exam ple: tracker@ yourcom pany.com

TLS (optional)  Select  this  check box if  your  server  uses
the Transport Layer Security encryption.

User name (optional)  Enter  a  user  name  if  the  e-mail  server
requires authentication.

Password (optional)  Enter  a  password  if  the  e-mail  server
requires authentication.

Web  Server
URL

The URL of your Comindware web server which will be
used as a link in body texts of e-mail notifications.

5. Click Test Connection to check the configuration and click Save to save the settings.

Configuring SMTP Server settings

Connecting To Microsoft Exchange Server

Comindware  Tracker  currently  supports  the  following  Microsoft  Exchange  Server
versions:

MS Exchange 2007 SP1;

MS Exchange 2010;

MS Exchange 2010 SP1.

To connect to MS Exchange server:

1. Go to Administration > E-mail Notifications. 

2. Select the Enable Outgoing E-mail check box.

3. Choose Microsoft Exchange Server as the e-mail server type.

4. Specify the following MS Exchange server details as specified in the table:

Value Description

Server type Choose Microsoft Exchange Server.



Comindware Tracker

122 www.comindware.com

Value Description

MS  Exchange
version

Choose  the  version  of  Microsoft  Exchange  Server
that is currently used on your mail server.

Exchange  Web
Service URL

Enter the URL to Microsoft Exchange Web Service.

Exam ple: h ttps ://s ervernam e/ews /exchange.asm x

Domain name Specify your domain name.

Exam ple: corp.yourcom panydom ain .com

User name Enter a user name.

Password Enter a password.

Web  Server
URL

The URL of your Comindware web server which will be
used as a link in body texts of e-mail notifications.

Exam ple: h ttp://yourcom panydom ain .com :8081

5. Click Test Connection to check the configuration and click Save to save the settings.

Configuring MS Exchange server settings
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Configuring Comindware Tracker To Create
Items From E-mails

This chapter includes the following topics:

Prerequisites

About creating tasks and items from e-mail messages

Creating a new account

Prerequisites

Who can perform this operation

Comindware administrators

Preliminary steps

Comindware Tracker Full license added 

Users and user groups added

Product keys for Comindware Tracker Full license assigned to users

Workspace created, workspace participants added

Applications created and configured

About Creating Tasks And Docs From E-mail
Messages

Your tasks and documents can be automatically created directly from e-mail  messages
sent to a particular e-mail address associated with an application. As soon as you send
an e-mail into such group, the  e-mail  becomes  a  task or document.  The  name  will  be
the e-mail subject, and the body of the e-mail will become a task or doc  description. E-
mail attachments will be converted into a task or doc attachment.

This feature may be useful in a number of ways, for example:

your staff can e-mail hardware or software  problems  to  your company’s  Help  Desk
department, and the e-mails will be converted into Help Desk Requests,

your  staff  can  send  document  preparation  requests  to  the  Human  Resources  or
Financial departments, and the e-mails will be converted into Document Requests.

external customers can e-mail problems to the Technical Support  Team, and the e-
mails will be converted into Support Incidents.

Creating a New Account

To  start  creating  tasks  or  items  via  e-mail,  you  should  create  and  configure  a  new
incoming e-mail account.
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Configuring Account Settings

To create a new inbound e-mail account:

1. Go to Administration > Create Items by E-mail.

2. Click the New Account button in the Ribbon.

3. Fill in the account settings:

Name Description

Application Select  an application  the  tasks  or  documents  will
belong to.

Mail  server
address

Type the address of the e-mail server, which hosts
the pre-registered mailbox.

User name Type a user name to access the mail server.

Password Type a password to access the mail server.

E-mail address Type  the  mail  address  of  the  pre-registered
mailbox.

Use encryption Enter the type of  encryption,  if  required  (available
to select: None, TLS, SSL).

Port number Set the port number or leave the default value.

Poll interval (min) Set the mail server poll interval in minutes or leave
the default value (10 minutes). The minimum polling
interval is 5 minutes.

Enable account Select the check box to activate the account.

Having specified all required parameters, click the  Test  connection  button in  the  ribbon
to try to establish connection with the mail server. Click the Save  button in the ribbon
to save the changes.
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Configuring account settings

Specifying Item Creation Options

Specify task creation or document creation parameters from e-mail messages.

Name Description

Accept
attachments

Select  the  check  box  to  add  a  message’s
attachments to a task or document.

Save  e-mail  as
attachment

Select the check box if  you want  a message to be
automatically saved as an attachment  to the task/
document being created.

Create  a  task/
item from any  e-
mail

Choose whether to create tasks or documents from
e-mails  sent  by  any  user,  including  both
Comindware  users  and  non-Comindware  users.  If
the  check  box  is  not  selected,  only  Comindware
users  granted  Owners,  Members,  or  Requestors
permissions  can  create  tasks  or  items  in  the
selected group.

Send  success
message

Select  the  check box to  send  a  notification  upon
successful creation of a task/doc.

Send  failure
message

Select  the  check box to  send  a  notification  if  an
error occurs while creating a task/doc.

Default creator Select  a  Comindware  user  who  will  be  set  as
creator of a task/doc by default. A default  user will
be set as task or document creator when an e-mail
message  is  received  from a  non-Comindware  user.
If an e-mail message is sent by a Comindware user,
the sender is set as creator of a task/document.
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Name Description

Default assignee Select  a default  assignee of  a  task being  created.
A  default  assignee  is  not  required  documents  and
workflow tasks.

Save  Requestor
data in

Select  the  text  field  to  copy  the  requestor's  full
name  and  e-mail  address  to.  It  is  recommended
that  you  create  a  text  field  for  this  purpose
beforehand, during template creation.

To save the changes click the Save button in the ribbon.

Item creation options

Configuring Automatic Replies

Comindware  Tracker can send  automatic  replies  upon  each  received  e-mail  message.
Automatic replies inform a requestor whether a task has been created or not.

Prior  to  activating  automatic  replies,  you  should  configure  global  outgoing  e-mail
settings in Administration > E-mail  Integration. See Configuring  outgoing  e-mail  settings

.

То activate automatic replies:

1. Go to Administration > Create Items by E-mail. 

2. Select the e-mail account, and click the Creation Options tab.

3. Select  the Send success message  check box to  send  a  notification when the  task/
doc has been successfully created.

4. Select the Send failure  message  check box to send a notification if  an error occurs
while creating a task/doc.

To change the subject and body text of auto response messages:
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1. Select  the e-mail account,  and  click the  Success Message  tab,  or Failure  Message
tab. 

2. On the Success Message  tab, specify the text  of the e-mail message, which will be
sent  to  the  requestor  upon  task/doc  successful  creation.  Type  the  subject  and
body of the message into the corresponding boxes.

3. On the Failure  message  tab, specify the text  of the  e-mail  message,  which will  be
sent  to the requestor if  an error occurs while creating  a  task/document.  Type  the
subject and body of the message into the corresponding text boxes.

You can apply text formatting or pictures to the message. Click the  icon in the Body
text field to open the rich text editor window.

Success message template
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Adding a Custom Logo

This chapter includes the following topics:

Prerequisites

About custom logo

Adding a wide/small logo

Adding a favicon

Adding a title

Prerequisites

Who can add logos

Comindware administrators

Preliminary steps

Comindware Tracker Full license added 

Users and user groups added

Product keys for Comindware Tracker Full license assigned to users

About Custom Logo

You can customize  Comindware  Tracker with  your company's  logo  and  favicon.  Users
will see your company logo and favicon every time they  use  Comindware  Tracker.  You
can upload two different size pictures as a custom logo.

Wide Logo

The wide logo is displayed on the login page in the top right corner and in the Menu tab
in the bottom left corner. The preferred size of the wide logo is 150x35 pixels. 

Small Logo

The small logo is displayed in the program header to  the  right  of  the  search box.  The
preferred size of the small logo is 24x24 pixels.

Favicon

The favicon is a small 16x16-pixel picture displayed in the address bar of your browser.

You can also change the Comindware title, set a URL and a tooltip for the logo as well.
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Adding a Wide/Small Logo

The wide logo is displayed:

on the login page in the top right corner

Custom Logo is displayed on the login page

in the Menu tab in the bottom left corner

Custom Logo is displayed in main menu

To add a wide logo:

1. Go to Administration > Custom Logo. 

2. Click  the  Upload  button  and  select  an  image  or  logo  for  your  organization.  The
preferred size of the wide logo is 150x35 pixels and the logo file must be in .gif, .jpg,
.jpeg, or .png format.

3. Type  the  logo  URL and  hyperlink tooltip  into  the  corresponding  text  boxes.  When
users click the logo they are taken to the page you designate in the  Logo URL box.
Text  from the Hyperlink Tooltip box will  be  visible  when the  user hovers  over your
logo.

4. Make sure the Enable check box is selected.

5. Click the Save button in the Ribbon.

Adding a small logo

A small logo is displayed in the program header to the right of the search box.

Small Logo is displayed in the program header

To add a small logo:

1. Go to Administration > Custom Logo. 
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2. Click  the  Upload  button  and  select  an  image  or  logo  for  your  organization.  The
preferred size of the small logo is 24x24 pixels and the logo file must  be in .gif, .jpg,
.jpeg, or .png format.

3. Make sure the Enable check box is selected.

4. Click the Save button in the Ribbon.

Reset to default

To reset  to default, click the Reset button or clear the appropriate text  box,  and  click
Save in the Ribbon.

Adding a Favicon

A  favicon  is  a  small  16x16  pixel  picture  which  personalizes  a  site  in  the  visitors'
Favorites menu.  A  favicon typically  appears  to  the  left  of  your browser's  address  bar
and on the browser tab next to the page's title.

To add a favicon: 

1. Go to Administration > Custom Logo. 

2. Click the Upload button and select a favicon file. The preferred size of the favicon is
16x16 pixels and the file must be in .ico format.

3. Make sure the Enable check box is selected.

4. Click the Save button in the Ribbon.

To reset to the default favicon, click the Reset button.

Adding a Title

The title of the page is displayed in the titlebar of the browser.

To add a page title:

1. Go to Administration > Custom Logo. 

2. Type the text of the page title.

3. Make sure the Enable check box is selected.

4. Click the Save button in the Ribbon.
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Backing Up The Comindware Database

This chapter includes the following topics:

Prerequisites

Creating a backup

Restoring data from a backup

Deleting a backup

Prerequisites

Who can back up the Comindware database

Comindware administrators

Preliminary steps

Comindware Tracker Full license added 

Users and user groups created

Product keys for Comindware Tracker Full license assigned to users

Licenses assigned to users

Workspace created, workspace participants added

Applications created and configured

Setting a Backup Location

Backups  are  stored  in  a  backup  location.  The  default  path  is  C:
\ProgramData\Comindware\Database\Backup\.  You  can  change  the  backup  location  to
another local or network folder by clicking the Set Location button and specifying a new
path. After you've changed a backup location, you will see only the  backups  stored  in
the selected backup location.

Creating a Backup

A  backup  is  a  copy  of  your Comindware  database  folder.  The  database  folder includes
your  database  files  and  attachments  from  tasks  and  items.  Creating  backups  is
necessary  to  prevent  data  loss  in  case  of  hardware  crash  or  error,  or  to  migrate
database files to different hardware.

To create a backup:

1. Go to Administration > Backup Management. 

2. Click New Backup.

3. Provide a description for the backup.

4. Click OK to start the backup process.
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Specifying a description for the new backup
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Restoring Data From a Backup

Restoring  Comindware  backups  is  performed  from  the  Comindware.DbRestore.exe
command-line utility located in the Comindware  installation folder.  The  default  path  to
the utility is C:/Program Files (x86)/Comindware/Products/Site/bin/.

To restore a Comindware backup:

1. Stop the Comindware Products application pool if Comindware Tracker is installed as
an IIS web site, or stop the Comindware Products service if  Comindware Tracker is
installed as a service. 

2. Run the ComindwareDbRestore.exe command-line utility with administrator rights:

o Click on the Windows Start button.

o In the Start Search box, type in “Cmd” (without quotes).

o Right click on the Command Prompt in the resulting search list.

o In the right click menu, click on the “Run as Administrator” menu item.

o Type-in  the  path  to  the  Comindware.DbRestore.exe  command-line  utility  (with

double quotes):

"C:/Program Files (x86)/Comindware/Products/Site/bin/Comindware.DbRestore.exe"

3. Go to the command-line utility and choose an action:

o To list  existing backups, type-in the following command (without  the "< " and ">"

symbols):

"C:/Program  Files  (x86)/Comindware/Products/Site/bin/Comindware.DbRestore.exe"
list <path_to_backup_location>

o To restore a backup, type-in the command (without the "< " and ">" symbols):

"C:/Program  Files  (x86)/Comindware/Products/Site/bin/Comindware.DbRestore.exe"
restore <path_to_backup_location> <path_to_target_location>

4. Start  the  Comindware  Products  application  pool  or  the  Comindware  Products
service.

Restoring a backup

Default paths

The default path to a backup location is:
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C:\ProgramData\Comindware\Database\Backup\. You can always find out the path to the
backup location and the list of available backups in the Administration > Backup
Management area.

The default path to the Comindware database is:

C:\ProgramData\Comindware\Database\

Deleting a Backup

You may delete unnecessary backups if you no longer need them.

To delete a backup:

1. Go to Administration > Backup Management. 

2. Select the backup from the list.

3. Click the Delete button in the Ribbon.

Alternatively, you can delete a backup manually from Windows Explorer or any other file
manager.
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CSV Import

This chapter includes the following topics:

Prerequisites

About CSV Import

How to Migrate Data Using CSV

Prerequisites

Who can perform CSV Import

Comindware administrators

Preliminary steps

Comindware Tracker Full license added 

Users and user groups created

Product keys for Comindware Tracker Full license assigned to users

Workspace created, workspace participants added

Application created and configured

CSV file containing data from another database

About CSV Import

You can migrate  existing  data  from other issue  trackers  or databases  to  Comindware
Tracker. Data migration is accomplished through a CSV  (comma-separated  value)  type
file. Any Excel file can be stored as  a  CSV  file.  You can also  update  existing  tasks  or
documents  in  a  particular Comindware  Tracker application with  new  data  from a  CSV
file.

Benefits

Quick migration process of all data from previous issue tracking system

Seamless migration: nothing will be lost or forgotten

Bulk update of existing Comindware Tracker tasks and documents with new fields

How it works

You have  created  one  or more  CSV  files  that  contain  data  from your  previous  issue
tracking system.

You add  the  CSV  file  to  Comindware  Tracker  and  map  CSV  file  fields  to  Comindware
Tracker fields.

If you need to add a new field to existing tasks or documents in an app, you also map
an existing Comindware Tracker field to a new field. A Comindware Tracker field  should
be created beforehand.
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Examples

Migration from your previous issue tracking system to Comindware Tracker.

How To Migrate Data Using CSV

To add data from a CSV file:

1. Log  in  to  Comindware  Tracker  using  Comindware  administrator  credentials,  go  to
Administration > CSV Import. 

2. Add a  CSV  file  to  Comindware  Tracker:  click  Add  CSV  file...  select  a  file  and  click
Open.

3. When the file is added, fill in the following settings:

Value Description

Data  source
CSV file

Select the CSV file the data source is based on.

Exam ple: BugL is t.cs v

Text
separator

Select  a  separator character that  is  used  in  the  CSV
file.

Values : com m a (,), s em icolon  (;), dot (.), tab, s pace.

Code page Choose a character set  used  in  the  CSV  file  from the
list of predefined character sets.

Exam ple:  Cyrillic  (W indows ),  Un icode,  Cen tral  Eu ropean
(Mac).

App  to  store
migrated
data

Comindware  Tracker  application  where  you  want  to
migrate data or update existing data.

Exam ple: IT Help Desk Reques ts

4. Customize the field mapping between the CSV  file  and  Comindware  Tracker.  Based
on  this  mapping,  new  items  will  be  added  from CSV  and  created  in  Comindware
Tracker.

In the Field Mapping area, select a corresponding Comindware Tracker field from the
drop down list which corresponds to a CSV field shown to the left.

5. Add a new field into existing Comindware Tracker items.

In the Unique Field area, select the Update existing items with a new field check box,
select  the  field  from CSV  and  the  corresponding  field  in  Comindware  Tracker.  The
Comindware Tracker field should be created beforehand.

6. When finished, click Import CSV File.
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Comindware Workflow For SharePoint

This chapter includes the following topics:

Prerequisites

What is Comindware Workflow for SharePoint

Configuring integration settings in Comindware Tracker

Configuring integration settings in Microsoft SharePoint

Prerequisites

Who can enable integration with Microsoft SharePoint Server

Comindware administrators to configure the Comindware Tracker part

Microsoft  SharePoint  site  collection  administrators  to  configure  the  Microsoft
SharePoint part

Preliminary steps

Comindware Tracker Full license added 

Users and user groups created

Product keys for Comindware Tracker Full license assigned to users

Workspace created, workspace participants added

Application created and configured (fields, form, workflow)

Microsoft SharePoint 2010 installed

Microsoft SharePoint site created

What Is Comindware Workflow For SharePoint

Your  company  may  already  use  Microsoft  SharePoint  for  document  exchange  and
collaboration.  However,  Workflow  management  functionality  in  SharePoint  is  rather
complex and requires programming.

Comindware  Tracker  includes  Comindware  Workflow  for  SharePoint™,  an  easy-to-use
graphical Workflow  engine  that  allows  creating  and  initiating  workflows  in  SharePoint
visually with no coding required.

Comindware Workflow for SharePoint integrates your existing SharePoint installation with
Comindware  Tracker,  workflows  ready  solutions:  Compliance  and  Policy,  Software
Development, Human Resources, IT  Help  Desk,  or any  your own solutions.  You will  be
able to visually create or modify your processes in Microsoft  SharePoint, and your team
will create requests in the familiar SharePoint environment.

Benefits

Build Workflows and business applications in SharePoint with a graphical Comindware
workflow builder that requires no coding.

Initiate requests and processes in SharePoint and track their status in real-time.
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Comindware Tracker® is easier and cheaper to deploy  and  use.  It  does  not  install
anything  inside  SharePoint  and,  thus,  does  not  involve  extra  associated  IT  costs
and associated IT costs and extra security and integrity issues.

Comindware  Workflow  for  SharePoint  works  with  the  native  SharePoint  user
interface, so users don’t get confused and don't have to learn anything.

How it works

You use  a  pre-designed  solution in  Comindware  Tracker or have  your  own  configured
solution in Comindware Tracker.

You use Microsoft SharePoint as a resource for document storage and collaboration.

You create a new site in Microsoft SharePoint.

You configure integration settings in Comindware Tracker, such as tasks that  your team
members  will  create  in  SharePoint,  a  SharePoint  web  site  where  these  tasks  will  be
created.

You re-login to Microsoft SharePoint and your integration is ready. Open the SharePoint
site and create a request.

When the request  is created, it  will be processed through the  workflow  in  Comindware
Tracker. When the request is completed, you will see the result in SharePoint.

Integration examples

Your team members  initiate  different  types  of  requests  from Microsoft  SharePoint,  for
example, create a Help Desk request, or a Purchase request.

How To Configure Integration with SharePoint Server

Integration  of  Comindware  Tracker  and  Microsoft  SharePoint  is  configured  on  both
sides:  Comindware  Tracker  and  Microsoft  SharePoint.  First,  you  configure  the
integration  settings  in  Comindware  Tracker,  then  configure  the  site  settings  and
security settings in Microsoft SharePoint.

Configuring Integration Settings In Comindware Tracker

To create a new integration with the Microsoft SharePoint Server in Comindware Tracker:

1. Log  in  to  Comindware  Tracker  using  Comindware  administrator  credentials,  go  to
Administration > Comindware Workflow For SharePoint. 

2. Click New Integration.

3. Specify general settings  for the  page.  In  the  left  part  of  the  window  that  opens,
select General > Integration Settings, enter page details:

Value Description

Name Enter a custom name for the  integration.  Integration
name is displayed only in Comindware Tracker.

Exam ple: IT Help Desk Reques ts
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Value Description

Description Provide  a  description  of  the  SharePoint  integration
workspace  just  to  remember  what  the  integration
does.

Exam ple:  Creation  of  Help  Desk  Tickets  and  reques ts  in
case of any hardware or s oftware problem s .

SharePoint URL The URL to your Microsoft SharePoint site.

Exam ple: h ttp://yoursharepoin ts ite.com :8081

Comindware
Tracker URL

The URL to your Comindware Tracker installation.

Exam ple: h ttp://yourcom puter:8081, where 'yourcom puter'
is  a com puter nam e or IP addres s , 8081  is  a port num ber.

Authentication Choose  the  authentication  mode  used  by  your
SharePoint server.

Values : NTLM, Kerberos , LDAP.

LDAP
membership
provider  name
(if  LDAP
authentication
selected)

Enter  the  name  of  the  membership  provider.  The
membership  provider must  be  correctly  configured  in
the  web.config  file  for  the  IIS  Web  site  that  hosts
SharePoint content on each Web server. It  must  also
be added to the web.config  file  for the  IIS  site  that
hosts SharePoint Central Administration.

Domain Enter your corporate domain name.

Login name Enter a user name for your domain user account.

Password Enter a password for your domain user account.

Status The  status  of  your  integration  with  the  Microsoft
SharePoint Server.

Values : Not Started, In  Progres s , Up-to-Date, Failed.

4. Add applications in  which SharePoint  users  will  create  tasks  or documents.  In  the
left part of the window go to General  > Apps, select  applications. Use the Add and
Add  all  buttons  to  add  the  selected  apps,  or Remove  and  Remove  All  buttons  to
remove the apps.

5. Specify visibility settings for each field. Go to Customize View, select  an application,
choose a field name and specify its settings:

Value Description

Read Only SharePoint users will not be able to modify this field.

Invisible The field will not be shown in SharePoint.
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Editable SharePoint users can change the value of the field.

6. Set  the  field  order  in  the  web  form.  Select  the  field,  click-and-hold  left  mouse
button and drag the field upward upward or downward.

7. When finished, click Save or Save & Close.

Configuring Integration Settings In Microsoft SharePoint

After  you  have  configured  the  Comindware  Tracker  part,  you  should  configure  the
Microsoft  SharePoint  part.  You must  have  the  SharePoint  site  collection administrator
permissions.

To enable integration in Microsoft SharePoint:

1. Open  SharePoint  administration  (click  Start  > Administrative  Tools,  and  then  click
SharePoint Central Administration). 

2. Click Manage  Web Applications and click New  to start  creation of a new SharePoint
application. Fill in the application details, click OK. The SharePoint application will be
created. You can also use an existing SharePoint application.

3. Add  users  who  will  create  Comindware  Tracker  tasks  in  SharePoint  and  assign
owners permissions  to  them.  Open site  settings,  click Site  permissions,  click Grant
Permissions. Add users, grant them Owners permissions.
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Enabling Single Sign-On

This chapter includes the following topics:

Prerequisites

About single sign-on

Enabling single sign-on in Comindware Tracker installation

Configuring single sign-on under IIS

Configuring your web browser

Prerequisites

Who can enable Single Sign-On

Comindware administrators

Preliminary steps

Comindware Tracker Full license added 

About Single Sign-On

The single sign-on feature allows a user to log in once  in  Comindware  Tracker without
being  prompted  to  log  in  again  next  time  when  a  user  wants  to  access  Comindware
Tracker.

Single sign-on benefits:

Reducing password fatigue from different user name and password combinations

Reducing time spent re-entering passwords for the same identity

Reducing IT costs due to the lower number of IT help desk calls about passwords

To  enable  the  single  sign-on  feature,  a  Comindware  administrator  should  modify  the
web.config  file  in  the  Comindware  Tracker  installation  folder.  As  soon  as  the  file  is
configured,  each  Comindware  Tracker  user  who  would  like  to  use  this  feature  must
configure  their  web  browser  by  adding  the  Comindware  Tracker  URL  to  the  list  of
trusted web sites.

External users cannot use the single sign-on feature.

Enabling Single Sign-On In Comindware Tracker
Installation

To  configure  the  single  sign-on feature,  you will  need  to  change  the  settings  in  the
web.config  file  located  in  the  product  installation folder.  Please  note,  that  after  each
update of Comindware Tracker the web.config file will be overwritten with the new one.
You will  need  to  back up  the  configured  web.config  file  before  update  and  restore  it
when the update is finished.
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To enable single sign-on:

1. Open the  Web.config  file  in  a  text  editor  such  as  Notepad.  By  default  the  Web.
config file is located in: 

C:\Program Files (x86)\Comindware\Products\Site\Web.config

2. Find the following line in the file:

<authentication mode="None"/>

3. Change the authentication mode from None to Windows:

    <!-- To enable SSO set Windows mode instead of None -->
    <authentication mode="Windows"/>

4. Find the following line:

    <!-- Uncomment to enable SSO -->
    <!--security>
          <authentication>
              <anonymousAuthentication enabled="false" />
              <windowsAuthentication enabled="true" />
          </authentication>
      </security-->

5. Uncomment the <sec urit y></sec urit y> block:

    <!-- Uncomment to enable SSO -->
    <security>
          <authentication>
              <anonymousAuthentication enabled="false" />
              <windowsAuthentication enabled="true" />
          </authentication>
      </security>

6. Save the Web.config file.

Configuring Single Sign-On Under IIS

If  your Comindware  Tracker  is  installed  as  an  IIS  server,  you  will  need  to  configure
Windows  Authentication  in  IIS.  The  default  authentication  configuration  for  IIS  7
enables Anonymous authentication only. 

Before  configuring,  make  sure  you  have  modified  the  web.config  file  as  described  in
Configuring Comindware Tracker files .

Installing the Windows Authentication Module 

1. Go to Start -> Administrative Tools -> Server Manager. 

2. Click Roles to expand it.

3. Click Web Server (IIS), then right-click and select Add Role Services.

141
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4. Select  the Windows Authentication  check box and  click Next.  If  the  box is  already
checked then that means the module is already installed.

5. Click the Install button.

Enabling Windows Authentication

1. Open  IIS  Manager:  click  Start,  in  the  Start  Search  box,  type  inetmgr  and  press
ENTER. 

2. Navigate to the Comindware Web-site item in the left pane.

3. In  Features  View,  double-click  Authentication,  or  right-click  on  Authentication  and
select Open Feature.



Comindware Tracker

144 www.comindware.com

4. On the Authentication page, select Windows Authentication.

5. In the Actions pane, click Enable to use Windows authentication.

Configuring Your Web Browser

After  the  Comindware  administrator  has  enabled  single  sign-on  on  the  server,  each
Comindware user who would like to use this feature should configure their web browser.
Single sign-on can be configured for the following browsers:

Internet Explorer

Mozilla Firefox

Google Chrome

Configuring Mozilla Firefox

Each Comindware user who would like to use single sign-on should add the Comindware
Tracker  URL  to  the  list  of  trusted  URIs  in  the  network.automatic-ntlm-auth.trusted-uris
parameter in Mozilla Firefox.

To enable single sign-on in Mozilla Firefox:

1. Open Mozilla Firefox. 
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2. In the address bar of the web browser type the following text: about:config. Mozilla
Firefox 3.x and later will ask for your permission to proceed.

3. In the Search box type the following text: network.automatic

4. Modify the network.automatic-ntlm-auth.trusted-uris parameter by double clicking on it
and  entering  the  URI  address  of  your  Comindware  Tracker.  A  comma  and  space
delimited  list  of  URLs  is  allowed,  for  example,  http://
<MachineNameWhereComindwareIsInstalled>,  http://
<OtherMachineNameWhereComindwareIsInstalled>

5. Restart Mozilla Firefox.

Configuring Internet Explorer

Each Comindware user who would like to use single sign-on in  Internet  Explorer should
add the Comindware Tracker web site to the list of the trusted web sites.

To enable single sign-on in Internet Explorer:

1. In Microsoft Internet Explorer, go to Tools > Internet Options. 

2. Click the Security tab and choose the Trusted Sites icon.

3. Click on the Sites button. A window will open, where you can add the sites that  you
wish to be in the Trusted zone. Be sure to remove the check by the  Require  server
verification (https:) entry.

4. Enter the Comindware  Tracker site  address  in  the  line  provided.  Site  URLs  can be
typed in directly or copied and pasted.

5. Click Add, the site will be added to the trusted sites list.

6. Click OK.

7. Click the Advanced tab.

8. Select Enable Integrated Windows Authentication check box.
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9. Click OK.
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Glossary

Chapter 8

Dashboard

Dashboards are used for real-time monitoring of what is going on in your department  or
the whole company and  regular reporting.  For example  with  dashboards  you can see
what  team members  are  overloaded,  what  project  has  a  lot  of  unresolved  issues,
whether your support team is coping with support tickets and whether the new version
of your product is stabilized enough to be released this Friday. Dashboards consist of a
set of widgets each of which is a separate graph.

Application

Applications are used to store similar items like support  requests, candidates, invoices
etc. You can set security rules for each application to define who can add items, view
them etc. Applications are then combined into workspaces so members of a particular
project  or department  can see  all  the  information that  is  important  for  them in  one
place.

Item

An item is some element  in Comindware Tracker. It  may be a task, a workflow task, a
document, a list, a dashboard.

List

Lists  are  created  to  help  users  sort,  filter and  manage  tasks  and  documents.  Some
lists are preconfigured ("My Active Tasks", "Completed Delegated Tasks"), some can be
configured  by  administrators,  or users  can  create  their  own  unique  lists  themselves
and even share them with other users. Lists are also used as a data source for building
widgets.

Parent

A parent (or a parent task, parent  document) is a task or document  which has one or
more  child  task or document  connected  to  it.  For example,  a  task  created  at  each
workflow step has its parent workflow task.

Recurring task

A  recurring  a  task  that  is  repeated  in  a  defined  period  of  time  and  needs  to  be
completed multiple times. Recurring tasks allow  you to  create  a  task once,  and  then
have it recreated automatically after a designated time period.

Step

A  step  is  a  building  block  of  a  workflow.  A  step  shows  the  current  position  of  a
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workflow task in a workflow. Generally, some work on a workflow task should be done
in a step, for example, "Review a document".

There are three different types of steps:

Start — the initial step  and  starting  point  of  a  workflow,  where  an activity  on a
workflow task begins. There can be just one step of this type in a workflow.

Intermediate  — the main  type  of  step  which is  used  for all  steps  between Start
and End. The number of Intermediate steps is unlimited.

End  —  the  end  of  a  workflow.  You  can  add  any  number  of  End  steps  to  a
workflow.

Subtask

A subtask is a task that is part of a parent task. Subtasks are necessary to delegate a
part  of work on a current  task to  another person.  Each task can have  the  unlimited
number of subtasks. Subtasks can also have subtasks.

Task

A Task is a simple activity that needs to be completed within a defined period of time.
Tasks  allow  users  to  effectively  distribute  roles  and  set  responsibilities  across
employees  or  departments.  In  Comindware  Tracker,  tasks  also  serve  as  triggering
events  to  move  a  workflow  task  to  another  step.  Thus,  a  workflow  task  can  be
managed by a set of tasks.

Task status

Each task has its  status  that  changes  during  task processing.  A  newly  created  task
has  the  Not  Started  status.  By  finishing  a  task,  its  status  switches  to  Completed.
There are six values that a task can acquire: Not  Accepted, Not  Started, In Progress,
Declined, Deferred, and Completed.

Transition

A transition is an element of a workflow that connects two steps. A transition provides
delegation of work on a workflow task to the next  step and, accordingly, to the  next
person.

Widget

A Widget  is a  chart  on the  Dashboard  that  displays  different  types  of  statistics  and
provides numerous reporting capabilities. Users can create their own different  types of
widgets  on  the  Dashboard,  and  configure  the  information  they  would  like  to  see.
Widgets take all necessary information from Lists.

Workflow task

When you need  to  start  a  whole  workflow  process  instead  of  an individual task you
create a workflow task. A workflow task can be  a  support  request,  help  desk ticket,
claim,  product  bug,  employee  record  — essentially  anything  you  want  to  be  moved
along and tracked. A workflow task is generally solved by  several people  in  turn  until
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the work is done. A workflow task has a workflow that allows it to move via transitions
through a series of steps from the initial to the final step. A workflow task belongs to a
particular workflow app.

Workflow

Workflow  is  a  sequence  of  steps  that  should  be  performed  to  get  your  work  done.
Each workflow step  has  a  task connected  to  it  and  assigned  to  a  particular person.
Workflows help you automate your processes.

Workspace

A workspace is a private area shared by a particular team or a user group. Workspace
allows its members to  collaboratively  organize  and  manage  work efforts  for a  certain
activity,  or  a  project.  A  workspace  may  refer  to  a  department,  project,  product,
client,  service.  Each  workspace  includes  its  own  applications  which  contain  tasks,
workflow  tasks  and  docs.  Activities  include  creating  and  managing  tasks  and
documents, monitoring performance through dashboards.
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